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Your InBox
Package

Who Should
Read This
Guide

Preface

Preface

s User’s Disk: TOPS InBox Macintosh User’s Disk

Includes:
— TOPS InBox
— TOPS InBox Setup

— InBox Help

: l D —  TOPS InBox Init

e Documentation: User’s Guide to InBox for Macintosh
This user’s guide describes how InBox for Macintosh works
and how to use it.

e Release Notes:
Additional information not included in the User's Guide.
Read the release notes first.

Refer to your TOPS packing list for details on other TOPS software
as well as the Customer Support Guide and Registration Card that
accompany your InBox package.

This guide is for you, the InBox user, whether you are just starting
out or are looking for details about how to use InBox . The guide
takes you through the setup procedures, showing you how to install
[nBox on your computer, connect to the InBox mail system, and
use all the features of the program.

For every InBox system there should be at least one person
responsible for setting up and managing the system as a whole—
an InBox administrator. For a small workgroup, this might be an

vii



Finding Out
About InBox

viii

individual who performs these duties as an adjunct to other
responsibilities. For a large organization, this might be a network
administrator whose full time is devoted to maintaining network
operations. (If you are the designated InBox administrator, you
should read this guide, to become completely familiar with how
InBox works from a user standpoint.)

As a user, if you have questions about InBox you should find most
of the answers in this guide. If your questions are specifically
about your own network and how InBox is set up on your network,
speak to your InBox administrator.

There are three ways to learn about the InBox program:

® This user’s guide describes how to set up InBox on your
computer and use all the InBox features, including sending,
receiving, sorting, and storing messages.

* On-line belp offers brief descriptions of how to use each of
the InBox features. Once InBox is installed you can obtain

help from the Apple menu or by pressing the # and the / kev
at the same time.

* The InBox administrator”s guides (see TOPS Administrator’s
Guide to InBox and TOPS Administrator’s Guide to InBox
Plus) contain more in-depth information about InBox and
the underlying system that distributes and manages InBox
messages.

Pre face
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Typeface Various typefaces are used to indicate the different meanings or
= context of certain words or phrases. The following list defines the
Conventions typeface conventions that appear in this manual:
Typeface Style |How the Style is Used An example
This typeface Normal text. Throughout this manual,
several typefaces are used...

This typeface Indicates figure and table titles, | See Chapter 3 of the Adminis-
book titles and chapter names, | trator’s Guide to InBox Jor
examples, and emphasis on Macintosh, for information
important words, . on...

This typeface Special headings, indicates 1. Make a working copy of
steps or processes which must your InBox user disk...
be done in sequence.

This typeface Indicates menu and menu From the File menu select
option names, dialog boxes Import text...

and window names and any
other screen or keyboard
option available for your use.

Preface
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About
inBox

Communicating through InBox

Chapter

Communicating
through InBox

InBox is an electronic mail system that provides a simple,
efficient means of corresponding with every other InBox user on
your computer network. InBox allows you to communicate with
users whether they have a Macintosh computer, and IBM PC, or a
PC compatible computer.

There are currently two versions of InBox—workgroup—level
InBox and InBox Plus. Workgroup-level InBox is designed for
communication between up to 20 users on a local area network.
InBox Plus allows communication between InBox users on a

broader scale and, in some cases, with users of a variety of other
electronic mail systems.

With both these InBox versions, you, as an InBox user, can:

e Send and receive Memos and Phone Memos.

* Send and receive Enclosures (files such as spreadsheets,
application programs, and formatted documents).

* Store messages and retrieve them whenever you need them.

In addition, InBox offers such features as:

* Personal Address Books, to let you choose from commonly
used addresses.

* Carbon Copy (CC) memos to people other than the primary
recipient.

* Automatic saving and printing of all memos you send.

* Sorting of messages according to date, subject, sender or
status.



A Typical
inBox Day

e Importing capabilities that let you incorporate any ASCII file
into your memaos.

As you go through this guide, you will learn about all the InBox
and InBox Plus capabilities. For now, the next section will provide
you with a brief look how you can use InBox.

InBox can immediately help you boost your productivity, and
continue helping you throughout your workday.

8:30 am

9:30

10:30

11:30

12:30 pm

Arrive at the office, turn on your computer, access
InBox, and see a list of three messages that came since
you left last night. (Receiving Mail, Chapter 5) You
select each one to read on the screen.

A phone message from a co—worker says Chuck
Malcolm wants you to call back ASAP. (Opening a
Message, Chapter 5)

Barbara Allen's message contains an Enclosure—a
spreadsheet with the numbers you need for the report
that's due by the end of the day. You save the Enclosure
in a file of its own; you'll be able to retrieve it when
needed. (Saving an Enclosure, Chapter 5)

Phil Brent sends a CC (Carbon Copy) of a memo in
which he promised marketing an East Coast market
analysis by Friday. You print it out and also save it on
your computer in a Storage Box you labeled “Markets.”
(Printing Messages and Storing Messages, Chapter 5)

You write a2 memo requesting all last-minute comments
on the draft proposal you sent out a week ago. You open
an Address Book and, with a single keystroke, send the
message to everyone you want to respond. With Return
Receipt on each copy, InBox will inform you when each
recipient opens his or her copy. (Addressing a Message.
Chapter 4 and Working with Address Books, Chapter 6

You retrieve the spreadsheet Enclosure, modify the
numbers to bring them up to date, and import it into
the report.

People are reading your memo. While working on the
report with your word processing program, several
Notices appear at the bottom of your screen. (Resetting
Options, Chapter 7)

A message from Phil Brent requests a reply. You turn

his original message into a reply form and send off

your response. (Replying to a Message, Chapter 35)

Chapter 1. Communicating Through InBox
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InBox Software:
The Electronic
Post Office

About InBox

1:30 Off to lunch. But before you go, you send a message to
yourself to remind you of a slight reorganization in your
report. “Reorganization” appearing under Subject on
the message list will remind you to look at the message
itself. (Sending Mail, Chapter 4)

2:30 Back at your desk, you receive several memos. You want
to see Barbara Allen's messages only, so you “screen”
your messages, listing only messages from Barbara
Allen in your Mailbox Message List window. (Listing
Messages, Chapter 6)

3:30 Barbara Allen's comments arrive, you incorporate them
into your report, print it, and do a fast proofing,

4:30 Time to send copies of the report to éveryone on your
list. You write an InBox Memo as a cover letter for the
report and attach the report as an Enclosure. (Attaching
Enclosures and Addressing a Message, Chapter 4)

Send a memo to Barbara Allen telling her the report is
off and thanking her for the numbers. A memo comes
back: Congrats on getting the report off.

InBox is an electronic mail system that works 24 hours a day,
whether your computer is on or off. If you receive a message when
your computer is off, you'll be notified that there's a message for
you when you turn on your computer.

You can also send messages day and night; it makes no difference
whether the recipient’s computer is on or off.

The ability to exchange messages so freely derives from the fact
that messages do not go directly from your computer to the
recipient's computer. Instead, messages go to a computer that has
been set up to receive and store messages, and to notify the
recipient that a message has arrived.

You can think of InBox as an electronic version of a postal
system, where each person has a mailbox right at the post office.
When mail arrives at the post office, it's sorted and inserted into
each recipient's mailbox.

With a real post office, you would have to go there, see if you have
mail in your mailbox, take any mail out, and take it with you. With
InBox, a Message List on your computer tells you there is mail in
your electronic “post office” mailbox; the list shows who the mail
is from and what it's about. If you are interested in reading a
particular piece of mail, instead of having to go and pick it up, just
indicate that you want to open it and the electronic message



appears on your screen. When you're done reading, the mail
remains stored in your mailbox in the “post office.”

Before you look at the specifics of installing and using InBox, it’s
important to look more closely at the basic components of InBox,
and how these components work together to provide InBox
capabilities.

An InBox system consists of these basic elements:

Basic InBox vl
Components .

e A Mailbox for each user

A Message Center

e Storage Boxes

InBox users can send two types of mail to each other: messages
and files.

A message is a written note in the form of:

e An interoffice memo

e A phone memo

You can enclose one or more files with either type of memo. The
files can be text files, graphics, formatted documents or
applications.

The Message A Message Center consists of users' f’ldraz‘!br.)xes an.d s?oftware for
Center sgrtl.ng ma;l. Like a postal system, in which }nall first goes to
distribution center or post office, all InBox mail first goes to the

— Message Center. Then Message Center software sorts the messages
%mﬁs* and puts them into Mailboxes for the recipients, just as a mail

InBox/
- clerk sorts mail and puts it into mail slots for delivery.

A single workgroup InBox Message Center can contain up to 20
Mailboxes and an InBox Plus Message Center can contain up to
100 Mailboxes. These mailboxes can belong to both Macintosh
and PC InBox users.

4 Chapter 1. Communicating Through InBox
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Mailboxes

Storage Boxes

it

E ]
et

Your InBox
System

Basic InBox Components

Every InBox user has a Mailbox on some Message Center. Like an
answering machine, the Mailbox holds messages for you
indefinitely. You can read mail at your convenience. Messages
remain in Mailboxes unless you delete or move them.

When you log in to your Mailbox, InBox displays a list of the
messages in your Mailbox. You can sort messages by subject, date,
or sender.

When you read your mail, it appears as though the information is
on your own computer, however, you are actually seeing
information that remains in a Mailbox on the Message Center,
located on some remote computer.

After you read your mail, you may want to keep some of your
messages. InBox gives you the option of creating Storage Boxes
where you can organize and store messages.

InBox Storage Boxes are like filing cabinets where you can store
information in an organized way. Like Mailboxes, you can open
Storage Boxes, see a list of the messages in them, and sort the
messages by subject, date, or sender. You can create as many
Storage Boxes as you want.

Storage Boxes differ from Mailboxes in that they are not located
on the Message Center. You can put Storage Boxes wherever you
choose—usually on you own computer, but also on a file-server,
or anywhere else on the network.

Every InBox system brings together all these elements—Message
Centers, Mailboxes, users, Storage Boxes. It requires a network
platform on which to function. The network provides the
communication link between InBox users and InBox Message
Center. InBox can be used by both Macintosh and PC users,
provided your network supports both kinds of computers.

As mentioned earlier, there are currently two versions of InBox—
workgroup-level InBox and InBox Plus. Workgroup InBox, which
is diagramed on the following page, is designed for communica-
tion among up to 20 users.

InBox Plus provides for communication between InBox users on a
broader scale and is described in the next section.



6

Most InBox communications are initiated by InBox users. Users
can send messages or make requests for information to the
Message Center. When the Message Center receives such requests,
it retrieves information, say, from a user's Mailbox and sends it to
the user's computer.

Workgroup InBox System

Macintosh InBox user

PC InBox user

e

= | e

—

I
ta
L

InBox

Message Center / // f/ // /

Chapter 1. Communicating Through InBox
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About
IinBox Plus

InBox Plus:

All the features of workgroup InBox ...

up to 100
Mailboxes

- more than 20 Mailboxes per Message Center

. TOPS o TOPS
s—— /ll-lﬂf)l . /In}ux_ —

«» distribution lists for use network-wide

As illustrated in the above diagram, InBox Plus offers all the
features of workgroup InBox, plus:

About InBox Plus

Up to 100 Mailboxes per Message Center.
You can go beyond the 20 Mailbox limit of a workgroup
InBox system. However, the InBox administrator (not the
InBox user) must create these mailboxes.



Note

* More than one Message Center per InBox system
You can communicate with as many InBox Plus Message
Centers as you like on your InBox system. Users on one InBox

Plus Message Center can send mail to users on any other

InBox Plus Message Center.

e Distribution Lists
An InBox Plus administrator can create enterprise—wide
distribution lists that speed the sending of mail to large
numbers of InBox users.

* Gateways to Other Mail Systems
InBox Plus offers the possibility of linking your electronic
mail system to other e-mail systems around the world—say,
in another office across the country or to nationwide and
international e-mail services and networks, such as AT&T
Mail, BIX, UUCP, VAXmail, The WELL or Telex.

This guide presents information for users of both workgroup-level
InBox and InBox Plus systems. As you proceed through this guide,
you will see notations, as appropriate, to indicate information that
applies to workgroup-level InBox or to InBox Plus, but not to
both.

Chapter 1. Communicating Through InBox
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Installing InBox

Chapter

Installing InBox

This chapter describes how to set up InBox on your computer. It

explains:

e  What equipment you need to use InBox

e How to install InBox on your computer

e How to log in to (or create) your own Mailbox

¢ How to change setup information after initial installation.

If, at any point, you are unsure how to proceed, please contact your
InBox administrator. As explained earlier in this guide, some
individual should have been designated as InBox administrator and
is responsible for setting up your InBox system and providing you
with an InBox User’s Worksheet. This Worksheet will assist you in
Installing InBox.



System
Requirements

Preparing for
Iinstallation

10

The InBox user program runs on a variety of computers, using a
variety of networks and network software.

Computer:  —

System: —

Network: —

Memory: -

Disk Storage: —

Macintosh 512KE, Macintosh Plus, Macintosh SE,
as well as the Macintosh Il and SE30 families.

Macintosh Finder™ version 6.1 or later. (To find
out what version of the Finder you have, from the
& menu select About the Finder.)

System release 6.0 or later on all models except
the 512KE. Recommendation for 512KE: System
4.1/Finder 5.5.

AppleTalk (Version 52 or later), FlashTalk and
EtherTalk network systems or any file—service
network (AppleShare, Novell, TOPS, etc.)

One megabyte

A hard disk. The InBox software will take up
about 500 to 750K of disk space. (InBox software
is distributed on 800 K diskettes.)

It is possible to run InBox from diskettes or from a
remote computer, rather than from a hard drive.
For information about installing InBox for either of
these situations, see the Release Notes that accom-
pany this software.

Proper preparation is necessary to ensure a successful InBox
installation. The installation procedure is a one—time task that takes
only a few minutes. In overview, the steps are:

¢ Fill in the InBox User Worksheet with your InBox administrator,
or obtain a form that has already been filled in by your InBox

administrator.

* If necessary, mount a volume (or open a volume, or map to a
volume, depending on your network system).

* Create a folder for the InBox program.

* Install the InBox software.
The software will generally be copied to your hard disk.

Chapter 2. Installing InBox
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Issues to Discuss
with your InBox
Administrator

Preparing for Installation

e Log in to a Mailbox.
“Tell” InBox where to find your Mailbox and choose a
password.

e Configure InBox.
Choose a folder to hold Storage Boxes on your computer and
specify your time zone.

There are a number of issues that will affect your installation. All of
these issues are covered by the information on your InBox User’s
Worksheet (discussed on the following pages), which you should
review with your InBox administrator. Being especially aware of the
following two issues will help your installation go as smoothly as
possible. One is whether you are on a workgroup-level InBox or
InBox Plus system. The other is whether or not you want to use
InBox as a Desk Accessory.

IinBox or InBox Plus?

Chapter 1 presented the basic components of InBox and described
the differences between workgroup InBox and InBox Plus. The type
of InBox system that vou have determines if you can create your
own Mailbox, and how many Message Centers there may be.

If you have a workgroup InBox system, you will have the capability
of creating your own Mailbox. Discuss with your InBox adminis-
trator whether a Mailbox has been set up for you, or if you should
create your own. Also, since workgroup InBox has only a single
Message Center, you will have only that Message Center to select
when you log in.

If you have an InBox Plus system, your InBox administrator must
have set up a Mailbox for you before you can log in. You will select
both the appropriate Message Center and your Mailbox during the
log—in process.

Using InBox as a Desk Accessory

Using InBox as a Desk Accessory may prove helpful if you are not
running under MultiFinder and you plan to move in and out of
InBox frequently. Using InBox as a desk accessory uses up a certain
amount of free memory. This may place some limitations on what
InBox functions you can perform, especially with Macintosh
computers with only 1 Meg of memory.

Discuss with your InBox administrator whether or not you want to
use InBox as a Desk Accessory. If you decide to use it as a DA, you
must install all InBox software in your System Folder.

1t
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InBox User’s Worksheet - Macintosh

INSTALL

1. Do you need to access
(mount) a remote volume
before using InBox?

] wNo.

O Yes.
AppleTalk—Mount Volume

Zone:

Server:

Volume:

Other File Service Network:

INSTALL

2. Where do you want your
InBox software installed?

O In the folder named:

D In the folder named:

System

(Recommended folder is named

(only if you plan to use the InBox

4. Where do you want to put
your InBox Storage Boxes?

Storage Box folder name:

“InBox") Desk Accessory)
LOG IN [:l No. D Yes.
3. \'\:(IHJPY OU create your own | The InBox Administrator has You can choose your own Mailbox|
EALDox: created the following Mailbox name and password when you
for you: create your Mailbox:
Message Center zone: Message Center zone:
Message Center name: Message Center name:
Mailbox name: Mailbox name:
Password: Password:
As soon as you set up the InBox |
software, change your password
o one that only you know.
CONFIGURE

(The recommended name is “InBox™ Storage Boxes Folder”)

CONFIGURE

5. Under Configure, you
need to set:

Time zone:

Daylight Savings Time (DST)

D Eastern D Atlantic D Yes D No.
[ central [0 vukon
O Mountin  [J Alaska/Hawaii
[:l Pacific
i E] East .
|:| Other min of Greenwich
D West

Chapter 2. Installing InBox
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InBox User’s
Worksheet

Before You
Iinstall InBox

Running
Setup

Preparing for Installation

The User's Worksheet on the previous page provides you with
information you need to prepare for and carry out InBox
installation. You should consult your InBox administrator to make
sure all sections are filled out before you begin installation.

The next two sections help you prepare for installation of the InBox
program: accessing a file server, if necessary, and creating a folder
to hold the InBox program.

Do You Need To Access a File Server?

Refer to Question 1 on your InBox Worksheet. If the answer is NO,
proceed to Question 2. If the answer is YES, you must access the
Message Center volume indicated on the Worksheet, otherwise you
will not be able to see your Message Center.

Where do you want to Install inBox?

Refer to Question 2 on your Worksheet. Before you begin
installation, you may have to create a new folder to hold your
InBox software. (No new folder is required if you plan to run the
InBox program as a Desk Accessory, since you will install all your
files in your System Folder.) If you are not going to use InBox as a
Desk Accessory, create a folder per instructions on the Worksheet.

If you are running a number of applications under MultiFinder,
close them all before you begin installation. Be especially sure that,
if you have another copy of InBox, it is not currently running under
MultiFinder.

1. Make a working copy of your InBox User disk and put
your original away for safekeeping.
Label each copy with the same name as the original. If anything
damages your working copy, you now have a backup.

2. Insert the copy of InBox User disk in the computer and
open it.

3. Double click on the TOPS InBox Setup.
The Setup screen on the following page appears.

This screen allows you to select Install, Log in, Config or
Remove. When you select Install, the installation process
automatically takes you through Installation, Logging In and
Configuration. Later you may want to run setup to change log-
in or configuration information, or to stop InBox from

13



functioning on your computer. These procedures are covered at
the end of this chapter under “Re-running Setup.”

TOPS InBox Setup

HD-40
fipot

Ready to install or configure InBox™.

Config

=
©
3
=]
=
)

Copyright @ 1989, Sun Microsystems, Inc.

At each step in the installation, refer to the completed InBox

Insta"ing Worksheet for the information you need.
II'IBOX 1. If you have more than one drive, click Drive until you
select your Startup drive.

2. Click on Install.

The InBox program copies the Init file to the System Folder and
the following screen appears.

Where do you want to install the InBox™ files?

You should put them in the system folder if you
plan to use InBox™ as a desk accessory.

O Correspondence

O Environmental Issues
3 My InBox
3 Publications
O System Folder
OO Utilities

InBox™ application name:
L (Cancel )

14 Chapter 2. Installing InBox
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Note

Logging In to
Your Mailbox

Installing InBox

3.

Select the folder for the remaining InBox software.

Refer to Question 2 on your Worksheet for the folder in which
to install InBox. If necessary, click on Drive to select the correct
drive, then double click on the name of the folder.

Click on Save.

After a number of files are automatically copied, the message,
“Searching for Message Centers, this process may take a while”
appears. When that message disappears, installation is complete
and the Setup program proceeds to the Log In process. The
Select a Zone dialog box appears, as shown on the following

page.

If the InBox program cannot find a Message Center an Alert
appears informing you of that. In that case, sce Appendix A,
“Troubleshooting.”

The next few pages describe how to log in to your Mailbox. The
instructions take you through the following steps:

Choosing the zone and the Message Center where your
Mailbox is located. (Remember, if you are on workgroup-level
InBox, you will only have a single Message Center.)

Selecting or Creating a Mailbox. (Remember, if you are on
workgroup InBox, you may create your own Mailbox.)

Entering the password.

The InBox installation program should take you directly to the first
step in logging in. If it does not, or if you are returning to log in,
select Log In from the TOPS InBox Setup dialog box.
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When the Select a Zone dialog box appears, it lists one or more
“zones.” If you have an AppleTalk-based network, there may be
several zones (sub-networks) in your system. If your network
consists of only one zone, you will see only two choices listed:
“File-Server Zone” and “Mail-Server Zone.”

Log (o to Mailbons
Select zone Where gour
- Message Eaenter Is lusatad

File-Server Zone

Business as Usual
Darnage Control

Ecology Zone
coned Out

No Mailbos chosen

(] Remember password

w1 [Concel)

1. Click on the Message Center Zone shown in Question 3 of
your Worksheet.

2. Click on Select.

Once you select a zone, InBox responds with Message Center(s)
located in that zone. At Select a Message Center, sclect the Message
Center where your Mailbox is located or, if you have yet to create a
Mailbox, where it will be located.

1. Click on the Message Center name shown in Question 3 of
your Worksheet.

2. Click on Select.

Chapter 2. Installing InBox
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Finding Your
Mailbox

Logging In to your Mailbox

Log In fo Mallboos
Seleet Messayge Eenier.

1 Ecology Zone I

Recycle Center

No Mailbox chosen

[] Remember password

When Log in to a Mailbox appears on the screen, see if your
Mailbox is among the Mailboxes shown on the list. (Refer to
Question 3 of the Worksheet.) If your Mailbox is not listed there
and you have to create your own Mailbox, continue with the next
section, “Create Your Own Mailbox.” If your Mailbox is listed, skip
the next section and continue with “Log In With Your Password.”
(If your Message Center is not listed and there is no Create button,
see your InBox administrator.)

Create Your Own Mailbox

If Create appears in your dialog box (you are on workgroup-level
InBox), then you can create a Mailbox.

17
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1.

Log (o o Maillboms
Saleet Mailbon

| Ecology Group |

Adrinistrator

Hope &live
Lotta Courage

Ertha Peal
Les Pollution

LEreate ]L Log in ][i:?s&mg;se)

No Mailbos chosen

[J Remember password

(oK) (Cancel)

Click on Create.
The following dialog box appears.

Create Mailbox with name and password

Name: [Seymnur Clearly [

Password: l |

I{ Add I | Cancel ][:I(Ziaag'?*e:ssamz'GDPuhlic

Type in the User Name and Password you want to use.

® This should be the name by which you will be known to
other InBox users. A Mailbox name can contain from 1 to
33 of the following characters:

All upper—case and lower—case letters of the alphabet
and Space , - . ' and 0123456789. (In both the name and
password, you can always substitute the upper—case
and lower—case of the same letter; in other words, the
software is not case sensitive.)

Chapter 2. Installing nBox
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Logging In to your Mailbox

5‘.\

e A password is not required (although it is very strongly
recommended). If you use one, it can contain up to 13 of

the following characters:

All upper—case and lower—case letters of the alphabet

and A ~Space!"#$%&' O*+,-./0123456789:;<=>@ .

For security reasons, dots appear instead of letters when
you type the password. Speak with your InBox admin-
istrator about sccurity, especially about how to handle

confidential information, financial, and personnel records.

Click on Add.

Confirm your password by retyping it and click on OK.

(To change the name or password on this Mailbox, first click on
Change in the Log in to a Mailbox dialog box, shown below.

Then retype the name and/or the password.)

Log 1o to Mallboms
Seleetd Mailbom

| Ecology Group |

Adrninistrator

Hope Alive
Seyrmour Clearly
Lotta Courage
Ertha Peal

[create ][ Login ](Change]

Successfully logged in as
Seymour Clearly @ Ecology Group

[J] Remember password

19



Log In With Your Once you've located, or created, your Mailbox, you can log in with

Password your password. A password will keep others who are using your
computer from reading your InBox messages and prevent them
from sending out messages under your Mailbox name.

1. Find your Mailbox name on the list and click on it.

Log o to Maillbons
Seleet Mailbom

] Ecology Group |

ddministrator

Hope Alive

Seymour Clearly

Lotta Courage
Ertha Peal

Ciogm )

No Mailbos chosen

[ ] Remember password

(%) (o)

2. Click on Log In.
The following box appears:

Mailbox Password:

I |
- (Gone)

3. Type the password to your Mailbox.
For security reasons, dots appear instead of letters as you type.

4. Click on OK.

20 Chapter 2. Installing InBox
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Logging In to your Mailbox

Log In to Mallboms
Seleet Mallhom

[ Ecology Group |

Administrator

Hope Alive

Seymour Clearly
J Lotta Courage
Ertha FPeal

Successfully logged in as
Seymour Clearly @ Ecology Group

[J Remember password

[ 0K ] [Cancel]

Bypass Entering Your Password

Normally, whenever you start using InBox you will have to enter
your password. To provide securily for your mail you should sign in
with your password every time you use InBox .

If security is not important to you, and if you do not want to enter a
password each time, select the Remember password option. (This
bypass works only from this computer. Anyone attempting to open
your Mailbox from another computer must know your password.)
1. Click on Remember Password.

2. Click on OK.

Changing Your Password

If your InBox administrator assigned your Mailbox a password, then
you should change your password as soon as possible after
completing installation. See “Making Changes,” Chapter 7.

If You Forget Your Password

[f you forget your password, your InBox administrator can assign
another to you.

21
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As soon as you have finished logging in, you can configure your
InBox installation. As described in the following pages, you can
choose where to keep InBox messages that you store on your own
computer and can designate the time zone where you are located.

Installation should take you directly to the first step in the
configuration process. If it does not, or if you are returning to setup
to perform configuration, select Config from the InBox Setup dialog

‘box.

InBox holds your received messages in your Mailbox in the Message
Center. However, if you wish, you can store your messages in local
Storage Boxes on your own computer. Here you have the

opportunity to select the folder where the Storage Boxes are to be
located.

* Click on Set Storage Boxes Folder.

Storage Boues folder

[ Set Storage Boxes fnlder]

Select a time zone

[] Daylight Savings Time

4K Cancel |

The dialog box that appears allows you to change drives, and
either make or select a folder to hold the Storage Boxes. You
can also click on Open Folder to view the contents of a folder.

If you have more than one drive, click on Drive to change
drives.

Chapter 2. Installing InBox
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Selecting a
Time Zone

Configuring InBox

O Applications

— HD-40

O Correspondence
O Eco Data §; = =
O Environmental Issues

O My InBox
[0 Publications
0 System Folder
O Unmentionables
O Utilities

reate folde

Select folder

Open folder
Cancel

To use an existing folder for storing InBox messages,
highlight one of the listed folders and then click on Select
Folder.

(If you want to reach a folder that is within another folder,
highlight the parent folder and click on Open Folder.)

To create a folder, click on Create Folder.

By default, the name “InBox Storage Boxes Folder” appears in a
dialog box. Either click on Create Folder, or type in a different
name and then click Create Folder.

Accurately recording the date and time when messages are sent
requires that the InBox program know your time zone. InBox
software contains a list of common time zones. It also has an option
for entering information for time zones that are not on the list. (For
this to work accurately, the clock on your computer must be set to
the correct time.) Refer to Question 5 of your InBox User’s
Worksheet.

1.

Click on the box under Select a time zone.

This box is set to “Eastern.” When you click on the box, you
can slide up and down the list of zones to select your time
zone.

If none of the time zones is correct for your location,
select Other at the end of the list.

In the box labeled min, type the number of minutes your time
zone is located east or west of Greenwich, England. Almost
every time zone is 60 minutes from its adjacent zones. So, if you
are in a time zone 2 zones east of Greenwich, then type in 120
(2 time zones X 60 minutes).

23
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3. Click on East or West of Greenwich, England.
For example, the Americas are west, and Australia is east of
Greenwich, England.

4. If you are now on Daylight Savings Time, click on that

box.
(An X within the box indicates daylight savings time.)

5. Click on OK.
Depending on what settings you made, an alert may appear

informing you that you need to restart vour computer for the
installation to take effect. Click on RESTART.

Just as the computer turns off before restarting, the following
message appears:

“InBox has been configured.”

You can exit the Setup program without restarting your Macintosh
by clicking on Quit.

As soon as Setup is complete you can quit Setup. The information
you have provided is stored, available for startup of InBox, as
described in the next chapter.

If you set up your InBox program with the intention of using it as a
Desk Accessory, then you can continue with the next section,
“Installing the InBox DA.”

If you want to install the InBox Desk Accessory (DA), be sure that
when you installed InBox all files were copied to the System Folder
on the disk you use to start your computer. (If you did not install all
InBox software in the System Folder, you can always re-install
InBox to prepare it for use as a DA; see “Reinstalling InBox”).

Either have your InBox administrator install InBox as a DA for you,
or obtain the Administrator diskette (Macintosh) or Utilities diskette
(DOS), which contains the InBox DA file.

If you are installing the DA yourself, proceed with the following
steps:

1. Insert a working copy of the InBox Administrator’s
diskette.

This diskette contains the InBox DA file.

Chapter 2. Installing InBox
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Re-installing

inBox

Installing the InBox DA

Find the Font/DA Mover wherever you have stored it, and
click to open it.

Click on the Desk Accessory button.

Open the right side of the dialog box and click on Drive.
Click until the name of the diskette containing the InBox DA
appears.

Click open the diskette.

) Font

@® Desk Accessory Meper

®Tops << Copy << ®TOPS InBox DA ...
®TOPS Spool
Alarm Clock
Calculator+
Camera
Chooser 197K bytes
| Control Panel selected

TOPS InBox DA
on HD-40 on InBox+ 3.0

12439K free 306K free

[ Close ] [ Quit ] [ Close ]

System

Click on TOPS InBox DA, then click on Copy
The InBox DA is installed as a desk accessory.

When you're done, click on Quit.

Restart your computer, making sure you are using the
Finder.
You can then select the InBox DA from the & menu.

There are a few reasons why you might want to reinstall InBox
software. For example, the software may have been corrupted, you
might have had a hard disk disaster, or you may have upgraded
your InBox software. In any case, use the backup disks you created
when you first installed the InBox program (or the new disks if you
are upgrading) and reinstall the software, starting from “Copy
Diskette and Run Setup” earlier in this chapter.

If you are reinstalling because of corrupted software, be sure that
you are not keeping any damaged files. Replace existing files during
the setup process. When you see, “File [filename] exists. Replace it?”

25
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click on OK. The choices are available primarily to allow you to
change your mind in case, for example, you begin reinstallation by
mistake.

Do not throw away the InBox preferences file (which contains
information on settings for your Address Books and other important
information) or your InBox Storage Boxes folder (unless you no
longer want to keep any of your stored messages).

If you are reinstalling for any other reason, save your current
settings, and replace files as you wish, except for Preferences and
Storage Boxes.

As you work with InBox, you may want to rerun Setup to change
the information in Log In or Configuration, or to “Remove” InBox
from working on your computer. You might want to change Log In
information for example, if you wanted to use a Mailbox on a
Message Center other than your own (for InBox Plus) or change the
name of your Mailbox (for workgroup InBox). You might want to
change Configuration information if, for example, you went off
daylight savings time, or wanted to specify new locations for
Storage Boxes.

To change information in either of those areas:

1. From your System Folder, open Tops InBox Setup.

2. Select Log In or Config, depending on what information you
want to change.

3. Follow the steps in this chapter under "Logging In" or
"Configuring InBox".

At some point, you may want to temporarily stop InBox from
running on your computer. To do this:

1. From your System Folder, open Tops InBox Setup.

2. Select Remove.
This will “remove” the InBox Init file from your System Folder.
You can still access your Mailbox from any other computer on
your InBox system. To regain use of InBox on your computer,
you would have to run Install again.

If you have a workgroup InBox system, the Remove button also
lets you remove your Mailbox from the Message Center. To
regain use of a Mailbox, you would have to create a new one.

Chapter 2. Installing InBox
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Getting Started

Chapter

Getting Started

InBox provides a rapid, easy-to-use means of sending clectronic
mail over your network. This chapter describes how to begin
working with InBox, including starting, quitting, and obtaining
help. By following the brief tutorial at the end of the chapter,
which describes how to send and read a message, you can learn
all the basics about using InBox.

How you start InBox depends on whether you installed the InBox

Desk Accessory:

e If you installed the InBox Desk Accessory, from the & menu
select TOPS InBox .

e If you did not install the InBox Desk Accessory, open the
folder that contains the InBox software and double-click on
the TOPS InBox icon.

When the InBox program starts, the following screen appears.

% File, Edit Send Uiew Customize IWindows

Menu Selections

Print Delete

Control Pad -
T R = InBox™ for Bed Herrmg ==

Status Subject From

Environmental dwar... Hope Alive

Mailbox Peace net Lotta Cour.
Message List
g Global Warming data  Les Polluti_.
W @ Lotta Courage Frank Lee...

. Re: Economic priorit... Ertha Peal
® Economic priorities  Perry Stro..
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The illustration on the previous page shows the main parts of the
InBox startup screen: The menu bar across the top of the screen,
the InBox Control Pad and the Mailbox Message List. The use of
the Control Pad and menus are discussed below under “InBox
Controls.”

Quitting InBox

To quit the InBox program, from the File menu select Quit or
press #Q.

Normally, when you start up your computer, The InBox Init file
loads into memory. If you wish to prevent the InBox from loading
into memory at startup, hold down the mouse button while your
Macintosh is starting up. The InBox Init file will not load, and
InBox will be disabled. To re-enable InBox, you will have to
restart your computer.

You'll find a number of different ways for you to operate the
software, including buttons, menus, and “shortcut keys”.

Selecting with Buttons

You can reach the InBox features you'll use most often through
the Control Pad buttons. The Control Pad is illustrated below.

Store Print Delete Memo  Phone

Store, Print, Delete - to handle mail you've received.

Memo or Phone - to open a new message window.

In addition, there are buttons within message windows. These
appear when and where appropriate, and allow you, for example,
to address the message you are working on or to attach an
Enclosure.

Chapler 3. Getting Started
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Getting Help

InBox Controls

To use a button, just click on it. Grayed—out buttons don't work
until their function is appropriate. (You can't click Send, for
example, until you have first addressed a message.)

Selecting From Menus

In addition to buttons, InBox includes a complete set of menus.
Many menu items duplicate functions that can be performed
using Control Pad buttons or message window buttons. In such
cases, this user’s guide directs you to use the buttons rather than
the menu equivalents. Other menu items are described in this
guide as they are needed to perform InBox functions.

Each menu covers a particular set of functions. For example, use
the Customize menu to access Storage Boxes, create Storage
Boxes, change your password, and so forth.

Click on Menu bar to
open a menu

Customize T .

Storage Boxes... 0
Address Books...

Use Mailbox... #®U
Set options... N Shortcut keys can

replace selecting
Change password... from a menu

The selections available on a menu may depend on the current
situation. For example,the View menu is used to choose whether
or not the Control Pad appears on the screen. When you pull
down the menu, you'll see either Hide Control Pad or Show
Control Pad, depending on whether the Control Pad is visible or
hidden at the time.

Using Shortcut Keys

Shortcut keys combine the Command key (8) with a letter, and let
you use the keyboard to implement a function rather than
selecting it from a pulled down menu. For example, use %8 U to
implement Use Mailbox, instead of pulling down the Customize
menu and selecting Use Mailbox.

While using the InBox program there are two ways to receive Help
directly on the screen:

e From the & menu select Help.

e Press 8-7?. (While holding down the 38 key, press the ? key.)

29
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When the TOPS InBox Help Main Menu appears, click on the

item you want help with. The help screens, which are self

explanatory, lead you through each of the major InBox functions
and features, explaining them in detail.

At this point, you're probably eager to try InBox. Just sending
yourself a message shows you most of the program's basic
functions:

1.

Click on the Memo button to open a new Memo.
The cursor appears in the blank after Re.

Type the subject of the message.

Click into the text area and then type the body of the
message.

Click the Address button on the message.

An Address dialog box appears with a Mailbox listing.
Click on your Mailbox.

TO appears next to your Mailbox.

Click on Send Now.

In a moment, the Status, Subject, From, and Date columns
of your Mailbox Message List will contain the appropriate
information about your message.

To read the message you just received, double-click on
the message icon in the Message List.

Finally, to close the window containing your message,
click on the close box in the upper left corner.

Chapter 3 Getting Started
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Chapter

Sending Mail

The basics of using InBox described in Chapter 3 take only a few
minutes to learn. This chapter presents more in—depth infor-
mation about handling outgoing mail, including information on:
e Opening the desired Memo form

¢ Entering Header and Footer information

e Creating the message

e Attaching Enclosures

e Addressing the message

¢ Sending or saving the message

InBox provides two kinds of new Memo forms for sending
messages:

e Memo
contains a header, an address area, and space for the body of
the message.

¢ Phone Memo

contains a header, an address area, the standard “While You
Were Out” check boxes, and space for the message.

You can attach an Enclosure to both Memos and Phone Memos.
An Enclosure is one or more files (such as applications, binary
files, or formatted documents) that you send along with the
message (see “Attaching an Enclosure,” later in this chapter).

When you receive a Memo containing an Enclosure, a @ appears
in the upper right corner of the Memo window next to Date.
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Note

As soon as the InBox screen appears on your computer, you can
send a message. (In fact, the only time you cannot send a message
is when a dialog box is open.) Before sending a message, first
choose whether you want to send a Memo or a Phone Memo,
then open the desired memo form.

You can have up to 32 Memo forms and 32 Phone Memo forms
open at one time, but only one of them can be active at any one
time. The active message window is the one in which you can write
a message.

There is a File Copies Storage Box in which you can save a file
copy of each message you send. (If you choose to use this feature,
be careful that you do not inadvertently fill your disk with file
copies of every message you send.) To save file copies, from the
Customize menu select Set options. Then click on Save file
copy.

To open the desired memo form:

1. Click on the Memo or Phone button on the Control Pad.
A Draft Memo or Draft Phone Memo appears with your Mailbox
name following From:,

Draft Memo 1

From:
To:

Date: ‘wed, Mov 15,1989 at 2:15 PM
Re: I

|2 <]

D Return receipt D Urgent

Chapter 4. Sending Mail
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Entering
Header and
Footer
Information

Headers

Opening Desired Memo Form

Draft Phone 1

From:

To:
Date: ‘wed,Nov 15,1989 at 2:15PM
Caller:
Of:
Phone :
Called S Wil can
Returned Call { Please call
i
&
D Return receipt D Urgent @J

In a Memo form, the header information lists the subject of the
memo. In a Phone Memo form, the header information repro-
duces the “caller” information in commonly used paper tele-
phone memo slips.

In both Memo and Phone Memo forms, the footer information
affects how your message will be displayed on the recipient’s
Message List. It also controls whether or not you are notified when
your messages are read.

To fill in the header information:

e For a Memo, type the subject of the Memo in the Re: blank.

e For a Phone Memo, type the caller's name, affiliation, and
telephone number. Then click on the appropriate check box
(Called, Returned Call, etc.). To remove a check mark, click
again on the check box.
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The two footer check boxes are Return receipt and Urgent.

|
[]Return receipt [ | Urgent E!I

If you check Return receipt, an “®” will appear in the Status
column of the recipient’s Mailbox Message List window. InBox
automatically sends you a message notifying you as soon as your
message has been read.

If you check Urgent, an “!” will appear in the Status column of

the recipient’s Mailbox Message List window.

If you check both Urgent and Return receipt, only the ®
appears in the Mailbox Message List window. Whenever the
recipient opens your message, however, whatever boxes you check
will show as checked at the bottom of the message.

To select footers:
e Click on the desired box(es)

® To uncheck a box, click on it again.

You can write and edit the message just as you would any other
text. There is an Edit menu that allows you to use common
editing functions such as cut, paste, and copy. You can also insert
text from an already created file. Inserting text is covered at the
end of this section. If it’s not a function you want to use, feel free
to skip it for now.

With the Memo or Phone Memo headers completed, write the
message.

Place the cursor within the body of the memo form and click
once, or tab to the body of the form. Type the message and use
all the editing functions of the Macintosh text editor, many of
which are in the Edit pull-down menu.

Chapter 4. Sending Mail
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Note

Inserting a
Text File Into
a Message

Note

Creating a Message

e Cut—to remove highlighted text
Undo typing %7 and save it in memory.
e Copy—to copy highlighted text and
Cut ®H save it in memory.
Copy #C ;
Paste %y e Paste—to insert text that was cut or
Clear copied.

e Clear—to remove highlighted text
Select all #*A without saving it in memory.

e Select All—to highlight all the text
in a document. (When there is no
open document, use this menu
selection to select all the messages
in any Message List window.)

belete messagy ¥R
Hadeiple megsage
Biscard deiplinng

You can select a font (style and size of print) for your messages
(see “Choosing Fonts,” Chapter 7).

No matter what font you choose for displaying your message,
messages will print in Times font.

If this is not a function you need to use, feel free to skip to the
next section. Return to this section, or continue with this section
whenever it becomes appropriate for you.

You may have already used a word processor to write something
that you want to send as a message or incorporate into a message
you dre writing.

To prepare the word processed file for incorporation, you must
first save that file as text (an ASCII file). The word processor you
used for creating the file should have directions for saving
documents in ASCII formal.

You can then insert the ASCII text file directly into the body of
your message. To do this, you place the cursor in the body of the
message where you want the text to appear, and then import the
text file using the steps on the following page. (The imported
version is a copy of the file—the original remains undisturbed.)

You can import a number of files into one message and then edit
them within InBox. The total size of the entire message, including
all imported text cannot exceed 30 K.
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Enclosures
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1. From the File menu select Import text.
The dialog box shown below appears.

2. Select the drive containing the file to import.
If you have more than one drive, click on Drive until the
drive you want appears.

3. Select the folder containing the file to import.
Highlight the folder and click on Open.

|

=) Applications = HD/40

[0 Correspondence _ L
O Eco Data £ilact

O Environmental Issues hivg

OO My InBoxr

3 Publications:

O System Folder
OO Unmentionalbles
o Utilities Cancel
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4. Select the file to import.
Highlight the file and click on Open.

The selected file is copied into the Message.

If this is not a function you need to use, feel free to skip to the
next section. Return to this section, or continue with this section
whenever it becomes appropriate for you.

When you want to send documents, data files, applications, or any
other files, you can send them as Enclosures attached to a
message. Enclosures are fast, easy, and secure ways to send
complex documents to your co-workers while retaining complete
control over the files you are making available. By sending an
Enclosure, you do not have to make files available to anyone
except the person that you want to receive them.

When an Enclosure reaches the recipient, it is identical to the file
that was on your computer. If you send, for example, a word-
processed document, the recipient can open the file with the
same software that was used to create it and see it just as it
appeared before it was transmitted, complete with formatting
codes.

Chapter 4. Sending Mail
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Note

Attaching Enclosures

InBox sends Enclosures exactly as they are; it does not translate
IBM PC files, for example, so that they are readable by Macintosh
software. There arce products available that perform some of these
MAC/DOS translations. In addition, there are many software
products—Excel®, Pagemaker®, Microsoft® Word are just a few—
that have Macintosh and DOS versions. Documents created with
one version of the product can easily be moved from one kind of
operating system to the other as InBox Enclosures, and then be
opened and used within the new operating system,

Attaching an Enclosure

1. Click on Enclose in the opened message window.
The dialog box shown below appears, and allows you to select
the files to enclose.

2. If you have more than one drive, click Drive to reach the
drive you want.

3. Select the folder containing the file to enclose.
As necessary, search through different levels of folders until
you find the folder that contains the file you want. (To move
back through levels of folders, place the mouse pointer on
box “A”. Press the mouse button, pull down to the selection
you want and release the button.)

oA A [tons = HD/40
O Correspondence

O Environmental Issues
[0 My InBox

Hripe
[T Publications [

o System Folder m
O Unmentionalbles _

[ Utilities Remoye

Files to enclose:

[

i

0K

Cancel

4. Select the file(s) to enclose.
Click on each name in the upper box and then click on
Enclose (or double—click on the name).
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Each of the files you select enters the box labeled Files to
enclose.

(Copies of the files are enclosed; originals remain
untouched.)

To remove a file name from the lower box, highlight the
name and click on Remove.

5. When you have made all your selections from one
folder, change to another.
Continue adding files 1o the box of Files to enclose.

There is no numerical limit to the number of files you can
enclose. You are limited only by your available memory.

6. When all the files you want to enclose are in the lower
box, click OK.
When the message form reappears it now shows a paper clip
in the upper right corner, next to the Date entry. This
indicates that the message contains an Enclosure.

You can always return to the Enclosure dialog box from the
message window, to add or remove an Enclosure. To return to the
dialog box, click on Enclose again.

Recipients see a paper clip in the Status column of their
message lists, to indicate this message contains an Enclosure.

You can send messages to anyone using InBox on your network,
(For workgroup InBox, you can send messages only to Mailboxes
on your own Message Center.) InBox Plus has two additional
addressing features—Gateway Addressing and Distribution Lists.
These are covered at the end of this section.

InBox allows you to choose addresses from the following two
sources:

e Message Center address lists
For workgroup InBox, you may select any address on your
Message Center. For InBox Plus, you may select addresses
from any Message Center on the network.

* Address Books, if you have created any
An Address Book is your personal address list. You can bring
together addresses from a number of sources to create your
Address Books. For information about creating Address
Books, see “Creating Address Books,” Chapter 6.

Chapter 4. Sending Mail
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1. To address the message, click Address on the open
message window.
When the address dialog box appears, the To button is
selected.

2. Select the first source (Message Center or Address
Book) you want to use to address your message.

e To switch between sources (Message Centers and Address
Books), place the mouse pointer on box “A”. Press the
mouse button, pull down to the selection you want, and
release the button.

Send: ®@To O CC (OBCC

«ll

[ setectAn ) [ Clear )

e To select the particular Message Center or Address Book
you want, place the pointer on box “B”. Press the mouse
button and pull down to the selection you want, and
release the mouse button. The address list for that
Message Center or Address Book appears in the scroll
box on the left side of the address dialog box.

Note The order of the list of Mailbox names that appears during
addressing was set up by your InBox administrator. You may find
it more convenient to select addresses from a list organized by
first or last name. If that is the case, see “Resetting Options” in
Chapter 7.

Addressing a Message 39
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Hint

3.

Click on the Mailbox of each person you want to receive
the message. Each Mailbox is marked with To.
To unmark a Mailbox, click on that Mailbox again.

¢ To mark all Mailboxes on the list, click on Select all.
(To unmark one of an entire selected list, hold down
Shift and click on that Mailbox.)

¢ To unmark all Mailboxes on the list, click on Clear.

Mark names to receive Carbon Copy (CC) and Blind Carbon
Copy (BCC).
Click on €C or BCC, then click on the appropriate Mailboxes.

You can decide who you want to be the primary recipients
(the “To’s”) and those who you want to receive “carbon
copies” of the message. You can select a number of To
recipients or one To and several CC recipients. Addressees
with To and CC attached to their names are listed as
recipients on the message and are included when a recipient
sends a “Reply to AlL” (See Chapter 5, Replying to a
Message.)

The Mailbox of the recipient of a blind carbon copy is
hidden from most recipients. The BCC recipient’s Mailbox
appears only on the sender’s copy of the message and on the
recipient’s copy. In addition, names of BCCs are not listed
when a recipient sends a Reply to All.

You can use Select All with CC and BCC, too. But, there must
be at least one To on the list before you can send a message.

If a message has an attached Enclosure and you want to keep a
copy of the message with the Enclosure, send yourself a copy.
Even if you choose to have a copy of each message you send
out stored in the “File Copies” Storage Box (See “Writing and
Editing a Message,” earlier in this chapter for information
about File Copy Storage Boxes) only the message itself (but
not any Enclosures) will be stored in that box. To save a
message with its enclosure, send yourself a CC or BCC.

Select all the Mailboxes you want on each Message
Center and Address Book.

Once you have selected all the To, CC, and BCC Mailboxes
from each Message Center and cach Address Book, in turn,
click OK. The message window reappears.

The Send Now button is there for convenience. Whenever
you write a message first and then address it, you can send it
immediately with Send Now.

Chapter 4. Sending Mail

TN naAARNRAnaAnAaannannnannnnn



'R ER R EEEEEEEEEEREERREEE

Note

Addressing a Message

As you begin using InBox software on a regular basis, and
especially if there are many Message Centers on your network (for
InBox Plus), you'll find it extremely useful to create Address Books
with lists of names. The Address Book allows you to make a single
list of names which you select from a number of different sources:
Message Centers, Memos you've received, and even other Address
Books. For information about creating this powerful tool, see
“Creating Address Books,” Chapter 6.)

Depending on which is more important to you, you can make
more room on either the address or the message portion of a
message window. Place the mouse pointer on the split line. When
the cursor changes to a double arrow, hold the button down and
move the split line.

Draft Phone 1

From: Seymour Clearly
To:

Date: ‘Wed, Sep 15, 1989 at 2:20 PM

Once you return to the open message window, you'll see all the
Mailboxes you selected at the top of the window. They are in the
form “Mailbox@Message Center.” For InBox Plus, there can be
several Message Centers on one network and this allows you to
distinguish between two people with the same Mailbox names on
different Message Centers.

If an address appearing on your message is so long that you can’t
see it all, just click on it. A box appears containing the entire
address.
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InBox Plus:
Distribution Lists

Note

InBox Plus:
Gateway
Addressing

In InBox Plus, Message Center Address Lists and Address Book
Address Lists may contain both the names of individuals and the
names of “distribution lists.” Distribution lists appear in italics.

Distribution lists are set up by your InBox administrator. Each list
consists of a number of individuals who are likely to want to
receive copies of your messages. For example, everyone in the
Accounting Department may be on one distribution lis, everyone
in Human Resources on another distribution list. A third list may
contain the names of everyone working on a special project,
regardless of department. You might even have a distribution list
that includes everyone in your company. To determine who is
included in each distribution list, check with your InBox
administrator.

When you select a distribution list name, you are sending the
message to everyone on the list.

When you choose Select all, you may be sending to individuals
who are also listed on a distribution list. In case of duplications
such as these, recipients will receive duplicate copies of your
messages. As this may prove annoying, avoid this type of
duplication by deselecting distribution lists when you Select all.

If you are on an InBox Plus system, and your InBox administrator
has set up special “Gateway” Message Centers on your network,
you can send mail through those Gateways to recipicents
throughout the world. Once Gateway Message Centers are set up,
worldwide communication (the exact destination depends on the
type of Gateway Message Center that's been set up on vour
network) is just as easy as sending local mail to the nearest
computer in your office.

Ask your InBox administrator for information about what external
electronic mail services you can reach through the InBox Gateway
Message Center(s) that may have been set up.

If Gateway Message Centers are sct up on your network, then you
can select any Mailbox on those Message Centers, or write in the
addresses of individuals not listed.

Selecting Gateway Addresses

You can select Gateway Message Centers and Mailboxes just as
you would any other Message Centers and Mailboxes. To select
existing Mailboxes on Gateway Message Centers, follow the steps

in the previous section under “Addressing the Message.”

Chapter 4. Sending Mail
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Writing In Gateway Addresses

You can send mail via a Gateway Message Center to anyone using
that external mail service (for example DASnet, Compuserve® or
AT&T Mail®) even when the person’s address is not listed on the
Message Center. With “Advanced Addressing,” you can type in
the name and address of the person to whom you want to send
the message.

1.

Addressing a Message

Begin with the open message you want to address.

Address the message by selecting names from Message
Centers and Address Books, as described previously in this

section.

From the Send menu select Advanced Addressing.
The “Addresses for Gateway” dialog box appears.

Move the pointer to the Addresses for Gateway box. Hold

down the button, move to the Gateway Message Center

you want, and release the button.

Addresses for Gateway: [ DASnet

=

| pone | ( Add ) ( Eair )

(Remoue)

Click on Add.

A dialog box appears with space to type in the name and

address.
Click on To, CC, or BCC.

®To:  [patsetopstech.sun.come@DASned] >

O Cc:

() BCC: -
I




Hint

6.

Type the name and address.

Use the name and address format required by the electronic
mail service you want to reach. Each Gateway Address can
have up to 512 characters.

If you are unsure of the type of external mail services
available through your Gateway Message Center(s), or what
address formats are required, then ask your InBox adminis-
trator for information.

Unless you take steps to save it, each Advanced Address you
enter is lost as soon as you send the message containing the
address. To avoid having to retype an Advanced Address
each time you use it, the best thing to do is enter it in an
Address Book. If you have entered it in a message address,
you can copy the address into an Address Book. Refer to
“Working With an Address Book” in Chapter 7 to see how to
add Advanced Addresses to an Address Book.

Click on OK.

The name and address you wrote is now added to the
Addresses for Gateway list.

Addresses for Gateway: [ DASnet |

@@ pats@topstech.sun.com@DASnet ~

&

2
[ Add ] [ Lt I Jﬁ?_‘%itiséﬁ_\'

Repeat the process for all the names you want to add
for that particular Gateway.

Then select each new Gateway and repeat the process until
you have written in all the addresses you wish.

Click on Done.

All addresses appear in the To section of your message.

Chapter 4. Sending Mail
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Sending
or Saving
a Message

Sending
a Message

Hint

Sending or Saving a Message

Once you have completed a message, you may send it
immediately, save it to send later, or save it to edit later. You
could, in fact, save a partially completed message at any point
after you have typed something in the message window. If you are
interested in saving a message, skip ahcad to that heading.

When your message is complete, first decide if you want to save a
copy of the message. If you do, begin with step 1. If you do not,
skip to step 2.

There is a “File Copies” Storage Box in which you can save a file
copy of each message you send.

1. To save file copies, if you have not already set this
option:

e Select Set Options from the Customize menu.

e Then select Save file copy, and exit from the dialog
box.

2. To send your message, click on the Send button.
Remember, to send a message the address must include at
least one To.

An alert box will appear with a series of notices, telling you,
one at a time, who is being sent the message:

“Sending Message to "

A Notice appears for each addressee who is on your own
Message Center. With InBox Plus, when you send messages to
recipients on another Message Center, the Notice informs you
only that the message is going to that Center, not to specific
individuals. (Once at the Message Center, the message is sent
to each recipient.)

Think about the message before you send it. The nuances
available in direct conversation (the wink or shrug) and
telephone conversations (chuckle or questioning inflection in
the voice) are not possible in a written message. Does the
message say just what you want it to say, without room for
misinterpretation?

45
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Delivery Time

If you send a message to a Mailbox on your own Message Center,
then delivery is almost instantaneous.

If you have an InBox Plus system and the message must go to
another Message Center or to a Gateway address, then the
delivery time is usually a few minutes to hours, depending on the
routing required. In certain instances, as described below, delivery
time could be quite a bit longer.

You can think of an InBox Plus routing system as consisting of
one “mailbag” on your Message Center for each Message Center
to which you can send mail. At a specific interval, that mailbag
and its contents travel to the other Message Center, delivering all
the messages. The interval between deliveries determines how
long it takes for the recipient to receive your message. An
overseas routing system could take days to send a message round
trip if, for example, the InBox administrator decides to hold all
messages and send them only during the nighttime hours when
overseas rates are lowest.

If a Message Is Undeliverable

You may receive an InBox “System Message” informing you that
4 message is undeliverable. Usually, the System Message lets you
copy the undelivered message to the Drafts Storage Box, where
you can keep the message while you determine why it was not
delivered, and then re-send it.

To save the copy:

* Open or select the message
* Click on Store

e Select a Storage Box, and click on Copy.

The only time the message itself might not be returned to you is if
it is sent through a Gateway Message Center on an InBox Plus
system. Even in that case, you will receive a notice that the
message was not delivered.

The most frequent reason a message is undeliverable is that the
address listed in an Address Book or Distribution list (InBox Plus)
is no longer valid (the recipient’s Mailbox may have been
changed, for example, but not updated in the Address Book).
Another likely cause is an incomplete Gateway Address. A third

cause may be problems routing the message to another Message
Center.

Chapter 4. Sending Mail

NANRANQRAARAQAANRNQANANNDNNDNDNDONN



UU WU LU UL L L L L LR LWL

Saving
a Message

Sending or Saving a Message

Note

You may be in the middle of writing a message and decide you
want to do something else. Or, if the message is important, you
may want to think about it before sending it off. You can save the
draft and then return to finish the writing later.

Saving a Draft Message

1. Click the close box in the upper left corner of the
message window.
The following “Alert” lets you choose whether to save the
draft or discard it.

This message has been
modified and not sent. Are

you sure you want to
discard it? Save as draft

Discard

Cancel

2. To save the message, click Save as draft.
Your draft message is filed in the Drafts Storage Box.

Finishing a Saved Draft

Saved drafts are automatically stored in a file called the Drafts
Storage Box. (However, when you are sending a message from
someone else’s Mailbox, with Use Mailbox on the Customize
menu, the draft message appears as “Unsent Mail” in the Mailbox
Message List window of the Mailbox you are using. For example,
you might use your own computer to send a letter from a co-
worker’'s Mailbox. In that case, drafts remain in the co-worker's
Mailbox Message List.) To complete a draft message:

1. From the Customize menu select Storage Boxes.

2. Double—lick on the Drafts Storage Box.
The window that opens contains a list any of draft Memos that
you have saved.

3. Double—lick on the message you want to open.

4. Continue writing where you left off.

If, for any reason, local storage is not available, your draft

messages are stored in your Mailbox.

m They appear in your Mailbox Message List window as
“Unsent mail,” with the status icon, shown to the left.
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Receiving
a Message

Receiving Mail

Chapter

Receiving Mail

InBox is designed to make it easy for you to handle your mail:
reading, responding, printing, storing and discarding it. When you
receive a message, it appears in your Mailbox Message List
window. This chapter describes the basics of handling your mail,
including:

Receiving a message
Opening a message
Replying to a message
Forwarding messages
Saving Enclosures
Printing messages
Storing messages

Deleting messages

InBox can notify you when a message has arrived:

When you are working in another application

InBox can notify you of the arrival of a message through a
visual alert at the bottom of the screen, and/or an audio alert.
(For information about turning on or off audible and visual
alerts, see “InBox Options”, in Chapter 7).

In addition, as long as there is unread mail in your Mailbox,
the InBox note icon flashes on the Apple menu header.

When you are using InBox

Information about the incoming messages is added to the
Mailbox Message List window, shown on the following page.
(Notices from your InBox administrator, however, appear in
boxes at the bottom of your screen.)
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l InBox™ for Seymour Clearly |
Status Subject From Date Time

! Environmental &wareness Plan Hope Alive Fri, Nov 17, 1989 318 PMQ
® Peace net Lotta Courage Fri, Mov 17,1922  Z:59 a4M
@ llj] Global Warming data Les Pollution Fri, Mov 17, 1939 2:36 PM
® iR Lotta Courage Frank Lee Speakin Fri,Mov 17,1983 10:15 &M
Re : Econamnic priorities Ertha Peal Thu, Mov 16, 1989 3:24 PM
Econornic priorities Perry Stroika Thu, Now 16, 1929 9:32 FPM
Recycle, Conserve Energy Les Pollution Thu, Nov 16, 1989 11:09 4M
Endangered Species Ertha Peal Tue, Mov 14,1989 9.52 aM
P Return Receipt Hope &live Tue, Mov 14,1989 Z.55 pM

Ecology Conference Les Pollution Men, Mov 13,1989 11:00 AM[_|

0]

Messages normally appear in the Message List window, first in
order of status (unopened before opened, for example) and then
by date sent. The Message List can also be sorted by Date, Sender
(From) or Subject (see “Listing Messages "in Chapter 0).

To extend the box to the right to view the time when messages
were received, drag the grow box at the lower right corner of the
window.

The symbols in the Status column provide useful information
about the messages:

Unread—You have not yet opened this message to read it.

Urgent—The person sending this message wants you to
know that it is important.

Return Receipt requested—As soon as you open this mes-
sage, a notice that you opened it is returned to the sender.

Symbols for urgent, unread, and Return Receipt requested
all remain on the list only until you read the message.

Phone Memo

System Message—A message from the computer system
that either informs you that a message has been read
(when you request a Return Receipt) or that a message is
undeliverable,

Enclosure—Attached to the message is one or more files.

Incomplete Message—In most cases you can open the
message and InBox will retrieve the remainder of the
message from the Message Center. If the message is not
recoverable, have the sender re-send it.

' Chapter 5. Receiving Mail
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Opening a
Message

Replying to
a Message

Opening a Message

To open a message, double—click anyplace on the line where the
message is listed. The message will open up an active message
window. The message might be a Memo or a Phone Memo. It
might also be a Return Receipt announcing that a message you
sent has been opened by the recipient, or a System Message
informing you that a message you sent is undeliverable.

You can open up several messages at once by first selecting
them—hold down the Shift key and click on each of them. (To
de-select, click on any unselected message.) Once you've selected
all the messages to open, double—click on any one of them.

You can select all of the messages by using Select all from the

Edit menu. (To de-select, hold down the Shift key and click on
any message.)

The number of messages you can open in this way depends only
on how much memory you have available. The last message to
open becomes the active message window.

You can reply to any message you've received. The original
message is retained to provide a context for your reply.

1. Open the message.

From: Ertha Peal@Ecology Group
To: Seyrour Clearly@Ecology Group

Date: ‘ed, Nov 15, 1989 2t 9:52 4 1]
Re- Endangered Species
Seymour,

Couldn't reach you by phone, so here's the latest.
Efforts to protect endangered species are making
headway. Flease look over the enclosed report
and forward it to the group.

2. Reply in one of two ways:

e Reply to the sender by clicking on the Reply button on
the open message window.

s Reply to everyone listed as “To” or “CC” on the original
message by holding down the Option key. When the
Reply button changes to Reply to All, then click on it.
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In response, the InBox program brings up a new message
window that contains:

* A header that identifies you as the sender.

* A new first paragraph explaining that this is a reply to an
earlier memo.

Seymour Clearly
Ertha Peal@Ecology Group

To:

Date: wed, Nov 15, 1989 at 2:2Z PM
Re: Fe: Endangered Species

In response to your letter received Wed, Mov 15, K p
1989 at 9:52 a4M

* * * * *

Seymour,

Couldn't reach you by phone, so here's the latest.
Efforts to protect endangered species are making
headway . Please look over the enclosed report
and forward it to the group.

D Return receipt |:| Urgent

[ [<7]

3. Write the reply.
For consistency, you may want to keep the reply above the
row of asterisks, but you can write anyplace in the message
window.

You can edit or erase any portions of the original message.
You can also add an Enclosure to the reply; for information.
about Enclosures, see “Attaching Enclosures” in Chapter 4.

4. Address the reply.
Whether you originally selected Reply or Reply to All, you can
add or change addresses on this message. (To address a
message, see “Addressing the Message,” in Chapter 4.)

5. To send the reply, click on Send.

Chapter 5. Receiving Mail
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Forwarding
a Message

Note

Saving an
Enclosure

Forwarding a Message

When you forward a received message, a copy of the original goes
to each new recipient.

1.
2,

Open the message to forward.

Click on Forward.

InBox changes the received message to a forwarded message:

e The header on the message is changed to show the
message is from you.

° A new first paragraph is inserted to explain that this is a
forwarded message. It names the original sender and
recipient, and shows the original date.

3. Write additions if you wish.
Before you send the message, you can write additions to the
original message (background information for the person
you're sending the message to, etc.), using all the editing
features found in the Edit menu. You can also save an
unfinished draft (see “Saving a Draft Message,” Chapler 4).
You cannot add any enclosures to a forwarded message. Any
enclosures that were included with the original message are
automatically included when the message is forwarded.

4. Address the message, just as you would an original
message.
(See “Addressing a Message”, Chapter 4.)

5. To send the forwarded message, click on Send.

If you receive a message with an Enclosure, a paper clip appears
under Status in the Message List and again, as a reminder, in the
upper right corner of the message, next to Date, as shown below.

From: Les Pollution@Ecology Group
To: Seymour Clearly@Ecology Group

Date: Fri, Nov 17, 1989 at 3:59 PM ]
Re: Global Warming Data

Eartha Peal@Ecology Group
Lotta Courage@Ecology Group
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Warning

Enclosures are files that are sent along with a message. They can
be files created with a software application—a word processor,
graphics, or spreadsheet application, for example. These
Enclosures can be saved in a folder and then retrieved with any
application that can read them. Enclosures can also be
application files or ASCII text files. They cannot be other InBox
messages.

Enclosures may use a large amount of disk space. Delete
enclosures or save them to storage as soon as possible.

To save an Enclosure:
1. Open the message.

2. Click on Save encl....
The box that opens contains the list of Enclosures.

Enclosures:

International studies
Satellite measurements

=

3. Click on the first Enclosure that you want to save and
click Save
The following dialog box appears:

B

[ Applications
O Correspondence

= HD-40

O Eco Data Jeet
O Environmental Issues Hyina
(O My InBox

[ Publications

Save file:

Internalionﬂl studies j Cancel

e B

Chapter 5. Receiving Mail
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Printing
Messages

Saving an Enclosure

4.

6.

If there are multiple drives, select the drive with the
folder you want.
Click on Drive until the appropriate drive appears.

Select the folder where you want to save the Enclosure.
If there are folders within folders, open a folder by double
clicking on it.

Click on the folder you want and click on Save.

The Enclosure is saved and the list of Enclosures reappears. If
there are additional Enclosures, the next Enclosure on the list
is now highlighted. You can repeat the process with remaining
entries on this list to save additional Enclosures.

When you're finished saving Enclosures, click on Done.

Before you print messages, check to make sure that the Page Setup
dialog box contains the correct settings for your computer and
your printer. (If you need to connect to a printer, or change
printers, from the & menu select Chooser.)

Setting Page Setup Options

1.

2.

From the File menu select Page setup.

A dialog box appears, similar to the one shown below. The
dialog box depends on the type of printer you selected in the
Chooser.

LaserlWriter Page Setup 5.2

Paper: ® US Letter (O A4 Letter (O Tabloid
O US Legal (O BS Letter Cancel

Reduce or Printer Effects:
Enlarge: %

[ Font Substitution?
Orientation [J Text Smoothing?

[ Graphics Smoothing?
g@ [ Faster Bitmap Printing?

B Print header

J0E

Adjust any page settings you want, and click on OK.

To print the address information on your messages, check the
Print Header box in the lower right hand corner. To suppress the
printing of address information (particularly useful for messages
with many addresses), uncheck this box.
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Storing
Messages
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Printing

You can print a single message or select a number of messages to
be printed one after the other.

1. Select message(s) to print.
* You can print any active message you have open; or

° From any active Message List (Mailbox Message List or
various Storage Box Message Lists), select the messages
you want to print.

To select more than one message, click on the first
message, then hold down the Shift key and click on each
additional message.

To select all messages on a Message List, select Select All
from the Edit menu.

2. Click on the Print button on the InBox Control Pad
The following dialog box appears.

LaserWriter “Biodegradable LIW*" 5.2

Cupies:@ Pages:® All ) From: l:' To: I:] . '

Cover Page: ® No (O First Page () Last Page

Paper Source: ® Paper Cassette (O Manual Feed

3. Adjust any appropriate printer settings and click on OK.
The program prints each of the messages you selected. No
matter what font appears on screen, the printed copy is in
Times font.

To stop printing, hold down the % key and press period (). To
suppress printing address information, see “Setting Page Setup
Options” on the previous page.

InBox allows you to store messages on your own computer in two
different ways—by placing them into Storage Boxes or by saving
them as text.

° Store a message in a Storage Box
When you want to keep the message and siill be able to
retrieve it and read it as an InBox message.

* Save a message as text
if you want to keep an ASCII file of the message. You can
retrieve a message saved this way with a program other than
InBox; a word processing program, for example.

Chapter 5. Receiving Mail
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Storing in a
Storage Box

Note

Storing Messages

Your InBox system comes with two built—in Storage Boxes:

e Drafts Storage Box—holds a copy of any message that you
start to write and then save as an unfinished draft.

e File copies Storage Box—holds a copy of every message you
send out (although the File copies Storage Box is always
available as part of the program, you must choose to have file
copies stored there—see “Resetting Options” in Chapter 7.).

In addition to these built—in Storage Boxes, you can create any
number of additional Storage Boxes to help you manage the
messages you receive. You'll find it easy to create Storage Boxes
for the different categories of InBox mail you receive. Then just
store your incoming messages in the appropriate boxes, for
retrieval anytime you want. For information on setting up and
using Storage Boxes, see “Working with Storage Boxes,” Chapler 6.

When vou installed InBox, you selected the folder where InBox
Storage Boxes are located. Anything you save to a Storage Box is
in that folder, not in your Mailbox on the Message Center
computer. Be sure to back up everything you save in your Storage
Boxes folder.

To Store Messages:
1. Select message(s) to store.
e You can store any active message you have open; or
e From the Message List, select the messages you want to
store.
To select more than one message, click on the first

message, then hold down the Shift key and click on each
additional message.
To select all messages on a Message List, select Select All
from the Edit menu.

2. Click on the Store button on the InBox Control Pad.
A dialog box opens with the names of all the Storage Boxes.

3. Click on the name of the box where you want to store
the message(s)
To create a new Storage Box, see “Creating a Storage Box” in
Chapter 0.

4. Move or copy the message.
Select Move to remove the original from the Message List.

Select Copy to keep the original on the list.
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Once you've finished working with a message you've received and
you want to save it in a text file:

1. Select the message to save just as you would select
messages to store.

2. From the File menu select Save as Text.
The dialog box allows you to specify where you want to save
the file.

Save message(s) to what file?
|
=y Eco Data
— HD-40
OO Water
|
HIg T

Append

<> Cancel

|

3. If there are multiple drives, select the drive with the
folder you want.

Click on Drive until the appropriate drive appears.

4. Locate the folder where you want to put the file.
Double click to open each folder and then double click on
the folder you want. (To return to the drive for any reason,
click on the drive symbol above “Eject.”)

5. Place the file in the folder you selected.

If there is already a file in the folder you selected, you can
append this message to the end of that file; click on the
file you want and then click on Append.

If you want to save it in a separate file, click on New File.
If there is no existing file in the folder you selected, then
you can only create a new file, not append to one.

For a new file, a dialog box appears with a request to
name the file.

Type the new file name and click on Save.

The message is saved in a file with the name you
requested.

Chapter 5. Receiving Mail
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Deleting
Messages

Note:

Deleting Messages

Just as with printing or storing, you can delete a single message at

a time, or a number of messages. Deleted messages are not really
gone until you discard deletions. Until you discard them, you can
display deleted messages on your Message Lists and you can
undelete them.

To Delete Messages:

1. Select message(s) to delete.
e  You can delete any active message you have open; or

e From any active Message List (Mailbox Message List or
various Storage Box Message Lists), select the messages
you want to delete.

To select more than one message, click on the first
message, then hold down the shift key and click on each
additional message.

To select all messages on a Message List, select Select All
from the Edit menu.

2. Click on the Delete button on the InBox Control Pad.
The message(s) is immediately deleted. Deleted messages are
not really gone, however, until you “discard deletions.” Until
you discard them, you can display deleted messages or
choose to undelete them.

To Display Deleted Messages:

You can choose whether or not to display deleted messages on
your Message List windows.

The last item on the View menu acts as a “switch” or toggle. Each
time you click on it, it switches between Show deleted and Hide
deleted:

If you selected Show Deleted, then messages do not just
disappear when you delete them—instead, a d appears next to
each one you delete as shown in the illustration on the following
page.

If you selected Hide Deleted, then messages are not displayed on
the Message List when you delete them.

If another user has logged in to your Mailbox, deleted and
discarded messages, then when you attempt to open a deleted
message, you will get the notice—“ALERT: Invalid Message 1D”.
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Warning

& File Edit Send Customize Windows

Hide Control Pad #K

Sort by...

Store Show only...

Print

Delete

Show deleted

HE
Status Subject From Date Time
® Environmental Awareness Plan Hope Alive Fri, Nowv 17, 1989 IS PM
Peace net Lotta Courage Fri,Nov 17,1989  3:59 aM
0 Globar Warming data Les Pollution Fri, Nov 17, 1929 2:36 PM
d& Lotta Courage Frank Lee Speakin Fri,Nov 17,1939 10:15 aM

Re: Economic priorities
d Economic priorities
d Recycle, Conserve Enerqy
Endangered Species
d Return Receipt

Ertha Peal
Perry Stroika
Les Pollution
Ertha Peal
Hope Alive
Les Pollution

Thurs, Mov 16, 1989 3:24 PM
Thurs, Nov 16, 1989 S5:ZZFPM
Thurs, Mov 16, 1989 11:09 AM
Tue, Nov 14, 1989 952 4M
Tue, Nov 14, 1989 355 PM

Ecology Conference Mon, Mov 13, 1989 1100 aM

To Undelete Messages:
1. Display deleted messages.

2. Select message(s) to undelete exactly the same way as
you select messages to delete.

3. Select Undelete Messages from the Edit menu
The message(s) immediately reappear in the Message List as
normal messages.

To discard Deleted Messages:

To permanently remove deleted messages, select Discard
Deletions from the Edit menu, or Quit InBox, or close a Storage
Box that has deleted messages.

Until you discard deletions (or Quit mBox or close a Storage
Box) all deleted messages, whether displayed on your Message
List or not, remain in your Mailbox.

Discard Deletions operates only for the currently active Mailbox
Message List or Storage Box Message List.

Closing a Storage Box which contains deleted messages automat-
ically discards all deleted messages in that Storage Box.
Quitting InBox automatically discards all deleted messages. There
is no warning and no way to stop this discarding once it begins.
Before you close a Storage Box, or quit InBox, make sure that
there are no deleted messages that you wanted to undelete.

Chapter 5. Receiving Mail
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Listing
Messages

Sorting
Messages

Managing Mail

Chapter

Managing Mail

Once you begin using InBox on a regular basis, you can benefit
from a number of InBox features that help you manage your
electronic communications more efficiently.

These include:

e Listing Messages: Sorting and filtering messages in Message
List windows

e  Working with Address Books

e  Working with Storage Boxes.

The messages in any of your Message Lists appear, by default,
sorted first in order of status (Urgent, Return Receipt, System,
unopened, opened, etc.) and then within each status, by date sent.
If you prefer, you can also sort the messages by Date, Sender
(From) or Subject. InBox also allows you to filter messages, so
only those that meet your specific criteria appear on the list.

You can choose to sort your messages by Date, Status, Sender (the
From column of the Message List window), or Subject.

1. Click on the Message List window to make it the active
window.
The current sort order is indicated by the underlined column
heading at the top of the Message List. For example, the
Status heading is underlined when the default sort is current.

2. To choose a sorting method, from the View menu
select Sort by.
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Filtering
Messages
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Hint

(O Sort messages by subject
O Sort messages by sender
(O Sort messages by status

@® Sort messages by date

3. Select one of the following options and then click OK:

* Sort messages by subject—Iisted in alphabetical
order.

* Sort messages by sender—listed in alphabetical order
by first name.

° Sort messages by status—with “Urgent” at the top of
the list, followed by “System Messages”, “Return Receipt,”
then “Unopened with no other special indications” and
“Opened.”

¢ Sort messages by date—with those sent most recently
at the top of the list.

As a shortcut you can resort your Message List by simply clicking
on the desired column heading at the top of the Message List. For
example, click on Subject to sort messages by by subject.

You can easily “filter” the messages you receive, according to who
sent them and what they are about. You do this by specifying text
in the Subject column or Mailbox names in the From column:

¢ Subject:
Text in the space after Re: appears in the subject column of
the Message List.

e From:
Text in the space after From: is the sender’s Mailbox name.

For example, you and a colleague may agree to start the Re: line
of your memos with the word “Financial.” Or, you may choose to
see only messages from one person by specifying that person's
Mailbox name in the From: column. This can help you separate

high priority memos from those that do not require your
immediate attention.

1. To filter messages, from the View menu select Show only.

Chapter 6. Managing Mail
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Note

Listing Messages

Show only messages that

@ begin with O contain ) end with
the following text:

@ in the subject column O in the sender column

2. Click on this text's position in the column.
Choose whether the column should begin with, contain (the
text is anyplace in the column) or end with this text. For
example, the phrase “Urgent Meeting Today” begins with
“Urgent,” ends with “Today” and contains “Urgent,” “Meet-
ing,” and “Today.”

3. Type the text or Mailbox name.
The filter feature is not sensitive to upper and lower case
letters, but is sensitive to spaces—for example, “Today” and
“today” are seen as the same, but “To day” is not. Be careful
to type filter text exactly as it appears.

4. Click on the column where you want the InBox
program to find the text or name: the Subject or the
From column.

The column heading you have selected will appear in italics
when you return to the Message List window. This will indicate
that messages are being filtered.

5. When you've made all the selections, click on OK.
Your Message List will now be filtered according to the
selections you've made.

To return to listing all messages received, retrieve this dialog box
and select Don't filter.

The ability to list only specific messages can be used o speed up
many features of the InBox program. Use a filtered list to enhance
printing, storage, and deletion of messages. For example, suppose
you have 40 messages on your Mailbox Message List. Twelve are
from the Mailbox “Jim Smith” and you want to place them all in
the Storage Box you've labeled “Jim Smith.”

In the “View only” dialog box, click on contain and type the
Mailbox “Jim Smith.” Click on in the sender column and click
on OK. From the Edit menu choose Select all. Then, click on the
Store button, highlight the “Jim Smith” Storage Box and click on
Move.
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Working with
Address Books

Creating an
Address Book
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Use an Address Book to create a selective list of addressees to
keep in one place. You could, for example, have one Address
Book containing the addresses of everyone, from various
departments, who happens to be associated with a specific
project. You could have another Address Book for your personal
friends, and a third containing co-workers in the same job
category.

You can send messages to specific addresses in a particular book
or, with a single click, send to all addresses in that book.

InBox allows you to use three different types of sources for
addresses when creating an Address Book:

* Mailboxes from Message Center lists
For workgroup InBox, you may choose Mailbox addresses
only from your own Message Center. For InBox Plus, you may
choose Mailbox addresses from any Message Center you can
ACCESS.

* Mailboxes from already created Address Books

Once you have created Address Books, you can use them as a
source for additional Address Books.

* Addresses from any message you have received and not yet
discarded.
If you wish to include the addresses from a message, it must
be the active message window. Click open that message before
you begin creating the Address Book.

For InBox Plus, this is a particularly useful feature when you
have a lengthy address used for sending messages over
Gateways.

1. To begin creating a new book, select Address Books from

the Customize menu.
This Address Books dialog box appears.

Address Books:

il £t

WL

@ Rempye
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Note

Working with Address Books

2.
3.

Click on New.

Type the name of the new Address Book in the dialog
box that appears and click OK.

The Address Book dialog box, shown below allows you to
select specific Mailboxes or (for InBox Plus) write—in Gateway
Addresses for inclusion in the new Address Book.

Select the first type of source for names to include.

To change from Message Center to existing Address Books, or
to an open active message, move the pointer to “A”. Hold
down the mouse button and pull down to your selection, then
release the button. If you select an open message, then skip to
step 6.

[ Message_center:] [ Ecology Group |

. W
Hdmlnls'IiiI K Hddr{g‘}nk: [WI
Hope Alir | PN
Seymour Clearly N
Ertha Peal
Les Pollution Gateway
Frank Lee Speakin 5 Addresses

Perry Stroika

B

it |i.z§£t.f, I

5 Add

Lotta Courage@Ecology Group

Cancel

Select the particular Message Center or Address Book
you want.

Move the pointer to “B”. Hold down the mouse button and
pull down to your selection, then release the button.

The address list is displayed on the left side of the dialog box.

In the address list window, click on the Mailbox you
want to add.

To add multiple Mailboxes, hold down the shift key and click
on each Mailbox.

Click on Add.
The Mailbox is added to the Address Book list in the center
of the dialog box.

To remove a Mailbox that you've already included in an
Address Book, just click on that Mailbox and then click on
Remove.




Hint

You can add Mailboxes from multiple Message Centers
(InBox Plus), Address Books, and an open message (if you
have one) to this Address Book. When you are finished
selecting Mailboxes from one source, change to another and
select Mailboxes from that one (at “B”). You can always
return to any source to add or delete Mailboxes.

8. To change the way a Mailbox appears in the Address
Book, select the name and click on Show as.
If, for example, the name you select appears as “James Smyth
@ Activel,” you might want to have it appear simply as
“James Smyth.” Just erase the “@Activel” part of the name.
(It appears this way only on your Address Book: the full name
and address appear on the memos you send.)

9. When you have completed the Address Book, click on
OK.

You can use Address Books to, in effect, create your own
distribution lists. While an InBox Plus administrator is the only
person who can create actual distribution lists, you can use the
Address Book feature to create your own de facto distribution lists.
For example, to send memos to everyone on a given project,
create an Address Book that contains the names of everyone
working on that project. Whenever you want to send a message to
the project team, open that Address book, select Select all from
the Address Book dialog box, and send the message.

Gateway Addresses

For InBox Plus, if there is a Gateway Message Center on your
network, you can select Mailboxes from that Message Center just
as you would for any Message Center. In addition, you can write in
the names and addresses of individuals accessible through the
Gateway.

To write in a gateway address:

1. Select a Gateway Message Center.
The Add button under Gateway Address becomes active.
Click on the Add button under Gateway Address.

Type in the first address for that Gateway, and click OK.
Repeat the process with all addresses for that Gateway. If you
want to add addresses for other Gateways, select your next
Gateway Message Center and repeat the process.

For more information about Gateway addresses, speak with your
InBox administrator or see “Gateway Addressing,” Chapter 4.
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Editing an
Address Book

Deleting an
Address Book

Note

Working with
Storage Boxes

Working with Address Books

Once you have created an Address Book, you can make changes
to it, including adding or removing names, changing existing
Gateway names, and changing the way a name appears in the
Address Book.

1. To begin editing an existing Address Book, from the
Customize menu select Address Books.

2. Click on the name of the Address Book you want to
change.

3. Click on Edit.
Use the dialog box that appears to add, remove, or edit
Mailboxes, or change the way a Mailbox appears in the
Address Book you selected. You can add, remove or change
the appearance of any address you selected. You can edit any
gateway address that you wrote in.

This is a powerful operation that can remove an entire Address
Book with a single stroke.

1. From the Customize menu select Address Books .
2. Click on the Address Book you want to remove.

3. Click on Remove.

Don't forget to back up your InBox files on a regular basis. Text,
and Address Book files you've saved are located on your compu-
ter (or disk your computer has mounted). Address Books, and
InBox preferences you have set, are in the InBox Preferences file,
so back that file up regularly.

InBox comes with two built—in Storage Boxes:

Drafts Storage Box
Holds a copy of any message that you start to write and then
save as an unfinished draft.

e File copies Storage Box
Holds a copy of every message you send out (although the
File copies Storage Box is always available as part of the
program, you must choose to have file copies stored there—
see “Resetting Options” in Chapter 7).
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In addition to these built-in Storage Boxes, you can create any
number of additional Storage Boxes to help you manage the
messages you receive. You'll find it easy to create Storage Boxes
for the different categories of InBox mail you receive. Then just
store your incoming messages in the appropriate boxes, for
retrieval anytime you want.

When you installed InBox, you selected the folder where InBox
Storage Boxes are located. Anything you save to a Storage Box is
in that folder, not in your Mailbox on the Message Center
computer. Be sure to back up everything you save in your Storage
Boxes folder.

You can open, view, and create Storage Boxes through the Storage
Boxes dialog box. You can also rename or discard any Storage
Boxes you create; you cannot rename or discard the File copies
or Drafts Storage Boxes. (To see whether InBox is set to save a file
copy of each message you send, from the Customize menu
choose Set Options. To keep a file copy of every message you
send, there should be an X next to Save file copy.)

To see a list of your current Storage Boxes, from the Customize
menu select Storage Boxes. The following window appears.

Tl

Storage Boxes:

Drafts =
File copies
New Approaches Done
Toxric Cleanup

Rename

@ Erase I

ket

To view the messages currently stored in your Drafts or File
copies Storage Box, double click on either one.

Chapter 6. Managing Mail
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Creating a
Storage Box

Retrieving
Stored Messages

Note

Working with Storage Boxes

You can create a number of different Storage Boxes for the
different categories of messages you receive. To create a Storage
Box:

1. From the Customize menu select Storage Boxes.
The Storage Boxes window appears.

2. Click on New in the Storage Boxes window.
A dialog box appears, requesting the name of the Storage
Box.

Name new storage box:

L |
o

3. Type the name, and click on OK.
The name of the new Storage Box appears in the Storage
Boxes window.

Renaming a Storage Box

To rename any Storage Box you have created:
1. Highlight the box to rename.

2. Click on Rename.

3. Type the new name and click on OK.

Retrieving messages from a Storage Box is similar to opening
messages from your Mailbox Message List.

1. Open the Storage Boxes dialog box by selecting Storage
Boxes from the Customize menu.

2. Double click on the Storage Box containing the
message to retrieve.
A list similar to the Mailbox Message List appears, except that
the list is headed by the name of the Storage Box you opened.

3. Double click on the message to retrieve.

To review messages in Storage Boxes when you are not currently
running InBox, open the Storage Boxes folder, and click on one
of the Storage Boxes. This “launches” the InBox application (you
must be connected up to your InBox system). Then proceed with
steps 1 through 3 above,
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Storage Boxes
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Note

To prevent you from unintentionally deleting messages stored in
Storage Boxes, a Storage Box must be empty before it is deleted.
Before attempting to delete a Storage Box, open it and delete the
messages. (See “Deleting Messages” in Chapler 5.)

To delete a Storage Box:

1. Open the Storage Boxes dialog box by selecting Storage
Boxes from the Customize menu.

2. Click on the Storage Box to delete.

3. Click on Erase.
If the Storage Box is not empty, the following Alert appears. In
that case, delete all messages from the Storage Box, and then
Erase the Box.

Only empty storage boxes can be deleted

Once you have deleted messages from a Storage Box, simply
close the Storage Box and all deleted message will be
discarded.

A Storage Box may appear to be empty after you have deleted
all messages. But it is not actually empty until you discard
deletions or close the open Storage Box.

Storage Considerations

If your mail occupies so much of your disk that you receive a
message warning you of insufficient disk space, refer to Appendix
A, “Troubleshooting.”

Chapter 6. Managing Mail
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Using
Another
Mailbox

Special InBox Features

Chapter

Special InBox
Features

This chapter describes many of the special features InBox offers
to make InBox easier, more efficient, and more specifically
tailored to the way you like to work. It explains how to:

e Use other Mailboxes.
¢ Manage windows
e Select type fonts

e Reset options (including how Mailboxes are sorted, whether
alerts should be turned on, saving file copies of sent memos,
etc.)

InBox lets you use any Mailbox on your Message Center, assuming
you know any password that’s required. This includes both Private
and Public Mailboxes. The Private Mailbox may actually be your
own, which you want to reach from someone else’s computer
because yvour own computer isn't working (or perhaps several
individuals share a single machine). The Public Mailbox may be
one that your InBox administrator set up as a kind of bulletin
board.

With InBox Plus, if you want to use a Mailbox on a Message
Center other than your own, you must run InBox Setup. Select Log
In to choose the appropriate Message Center and then log in to
the desired Mailbox.
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If you want to manage your mail when working at someone else's
computer (or check someone else's mail at your own computer,
assuming you know the password of the Mailbox you want to use):

1. From the Customize menu select Use Mailbox.
2. Click on the Mailbox you want to use and click on OK.
3. Type the password and click on OK.

You are now logged in to a Mailbox different from the one for
which Storage Boxes were originally set up on the computer you
are using. This means the Drafts and File Copies Storage Boxes do
not support the Mailbox you are currently using.

If Save File Copy is selected in the Options dialog box of the
Mailbox you are currently using, then a copy of each message you
send is not saved to the File Copies Storage Box on the computer
you are using. The copy is mailed, rather, to the Mailbox you are
currently using. It then appears in the Mailbox Message List of that
Mailbox.

Similarly, if you are interrupted while working on a memo and
save the memo as a draft, the draft memo is not stored in the
Drafts Storage Box on the computer you are using. Rather, it
appears as “Unsent Mail” on the Mailbox Message List of the
Mailbox you are currently using.

You cannot save this message to the local Drafts Storage Box. You
could, however, save it to some other local Storage Box. To do
this, select the message from the Message List, then click on the
Save button. Select any local Storage Box on the computer you
are using, except Drafts, and save the message there. There is no
way for you to save that message to a Storage Box on any
computer other than the one you are using.

A Public Mailbox serves as a kind of bulletin board; a place where
anyone can leave a message for anyone to read. Depending on
how the InBox administrator sets them up, access to Public
Mailboxes may or may not require a password. If access does
require a password, then only a controlled group of people on the
network can use the Mailbox. Without a password, the Public
Mailbox becomes available to everyone who has a Mailbox on
the Message Center where the Public Mailbox is located.

Send mail to a Public Mailbox just as you would send mail to any
other Mailbox.

Chapter 7. Special InBox Featitres
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Note

Working with
Windows

Using Another Mailbox

To read mail in a Public Mailbox:

1. From the Customize menu select Use Mailbox.

2. Click on the Public Mailbox you want to use and click on
OK.

e If there is no password, you are immediately able to view
the Message List for this Mailbox.

e If a password is required, type the password and click on
OK.

3. Click open any messages you want to read.

Once you have selected a Public Mailbox, you can also send mail
from it, just as you would from your own Mailbox. The mail you
send will be identified as coming from your own Mailbox.

If you are interrupted while working on a memo and save the
memo as a draft, the draft memo appears in your own Drafts
Storage Box. Also, if Save File Copy is selected in your Set
Options dialog box, then a copy of each message you send
appears in your own File Copies Storage Box.

Almost everything in InBox is done through windows: viewing
Message Lists, writing, forwarding and replying to messages,
opening messages from Storage Boxes, and numerous other
functions. The information in the following sections helps you
manage windows.

Keeping Track of Windows

You may have many different InBox windows open. The window
containing the InBox Control Pad always “floats” on top of the
open windows. You may “hide” this control pad by selecting Hide
Control Pad from the View menu.

To keep track of the other windows, and to decide which one
should be “active” (the one to be currently in use) pull down the
Window menu. The bottom of that menu names each of your
open windows. Use the mouse to select the window you want to be
active. (The active one contains a check mark next to it.)
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Keeping Window Size and Position

Once you have selected the size and position of InBox windows,
you can keep them that size and position whenever you retrieve
them. You can:

e Save the size and position of Message List windows.

* Save the size and position for all Storage Box windows.

® Save the size and position of outgoing messages. Whenever
you begin to write a new memo, for example, the form that
appears will be the size, and in the position, you requested.

(Incoming messages appear the same size as they were sent.)

To save the size and position of an active window, from the
Windows menu select Remember position.

Message Information

Anytime you want information about a specific window, you can
find out easily by selecting Get info from the Windows menu.
Depending on which window is active you can find out:

* Mailbox Message List Window and Storage Box Message List
Windows

— Number of messages
— Number of messages marked for deletion

— Number of unread messages.

e Memos
— Originating platform (Macintosh or PC)
— Number of addresses
- Message size
— Contents size
e Drafts
— Number of addressee(s)

— Contents size.
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Choosing

Fonts

Choosing Fonts

Note

The InBox program provides a variety of type styles and sizes
(fonts) for you to choose from. You can select the font for a
specific message or you can choose the font you want to be used
for all subsequent messages (the default). You can even select the
font in which you want any of your Message Lists to appear.

To select the font for a specific message or Message List, it must
be the current active window.

The size and style of font you select for an outgoing memo
appears on the recipient's Macintosh computer just as you
selected it. When the memo appears on an IBM compatible
computer, however, the characters are in the standard IBM
character set. Also, no matter what font you choose for displaying
the messages, they will only printin Times font.

1. From the Windows menu select Set font.
The following dialog box appears.

Geneva
Chicago O m
ChicagoSymbols 10
Courier 12
Garamond 14

I Geneva ] 18
Helvetica 20
| Courier Obligue 24
| Garamond Lightltalic
| Helvetica Obligue Iy )

[Juse as default

2. Click on the name and the size of the typeface you
want to choose.
A sample of the style and size typeface you select appears in
the box above the font list.

e If the selection is for the open message (or Message List)
only, click on OK.

e If the selection is for all subsequent messages (or all
subsequent Message Lists, including Storage Box Message
Lists), click on Use as default, then click OK.
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You can customize InBox to your own preferences, by changing
your password and resetting a number of other options.

Changing Your Password

If your InBox administrator assigned you a Mailbox and used your
name as the password, then you should change your password as
soon as possible. After that, for tighter security, change the
password often. Use random letters and numbers rather than your
home phone number or relative's name, and do not write down
the password.

1.

From the Customize menu select Change password.

Type the old password you want to change and click on

OK.
For

security, bullets appear instead of letters.

Type the new password and click on OK.

Type the new password again, to be sure it is correct.

Clic

k on OK.

Resetting Options

To change any of the following options, from the Customize
menu select Set options.

Sort Mailboxes by:
Refers to Mailboxes in Message Center address lists.

First name
Last name

Admin order
The order in which the InBox administrator has chosen
to place them.

Alerts:
The following alerts appear when you are working in an
application other than InBox.

Audio

Select this for an audible signal announcing each message
you receive.

Video

Select this for an on-screen notice that you have received
a message.

Flashing icon

Select this for a flashing InBox message icon to notify you
that you have unread mail.

Chapter 7. Special InBox Features

nnnnannNANnNNNNNRAnnnNnNNnNnanNn



GUUuUUuUUUUUUUUUUUUUUNUNENUU

VMaking Changes

Additional options:

Remember password

Normally, whenever you start using InBox you will need
to enter your password. If you do not want to enter a
password each time, select this option. Remember
password works only from this computer. Anyone
attempting to open your Mailbox from another computer
must know your password.

Save file copy
Select this to store a copy of each message you send, in
the File Copy Storage Box.

Print sent messages
Select this to print a copy of each message you send.

Daylight Savings Time

Select this during Daylight Savings Time. Turn it off for
standard time. (You can use this option from the Set
Options dialog box, rather than rerunning Setup to
reconfigure Daylight Savings.)
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Troubleshooting

Appendix

Troubleshooting

While installing or using the InBox software, you may occasionally
encounter difficulties. This appendix provides some guidelines for
diagnosing and solving commonly encountered problems.

If you are uncertain how to perform a certain function with InBox,
check the Table of Contents for the chapter that describes the
function in question. This appendix discusses only unexpected
problems. Problems related to InBox Administrator software are
found in the appendices of the Administrator’s Guide to InBox for
Macintosh, Administrator’s Guide to InBox Plus for Macintosh and
Administrator’s Guide to InBox for DOS.

Your first step is to determine the nature of the problem you are
experiencing. The problems discussed in this appendix are grouped
according to where you might encounter them:

¢ Installing InBox

e Starting Up InBox

¢ Sending and Receiving Mail

If you already know where your problem lies, go directly to the

section in this appendix that discusses that activity.

If you are unable to resolve your problem after consulting this
troubleshooting guide, please refer to the section “TOPS Technical
Support” at the end of this appendix. This section lists the
information you should collect and have available when you call
TOPS Technical Support for additional assistance.
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The Setup program cannot find any InBox Message Centers.
Investigate the following:

Check with your InBox administrator to see that the Message
Center computer is turned on.

If using a Macintosh and AppleTalk, check to make sure that
the AppleTalk connector is plugged tightly into the printer port,
and that AppleTalk is set as “active” in the Chooser.

Use whatever other network software is available on your
machine to access printers or network servers. If this software
is not functional, check cabling and connectors.

If using a file—server Message Center, check to make sure that
the appropriate volume is “mounted”.

If using a mail-server Message Center, ask the administrator to
check if the Message Center is currently “open”.

If using a mail-server Message Center, ask your InBox
administrator to check the number of active connections on the
Message Center via the Control Panel. This number should be
equal to or higher than the number of users that are
concurrently accessing the Message Center.

The Message Center is visible, but you can’t see your
Mailbox.

The following items should be checked:

Iinstalling
inBox .
80

Make sure that you are looking in the correct AppleTalk zone,
on the correct Message Center. In many InBox configurations
there may be more than one Message Center.

In some installations you may be responsible for creating your
own Mailbox. If you (or someone else) have not done this,
then you will need to do so.

If using an InBox Plus Message Center, check to make sure that
your InBox administrator has created a Mailbox for you.

Scroll through the entire list of names on the Message Center.
The ordering of Mailboxes is changeable. Your Mailbox could
be anywhere on the list.

Appendix A. Troubleshooting
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Starting Up InBox
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The message “Missing Resource” occurs when starting the
InBox user program or Desk Accessory.

One of the InBox files has been changed or deleted. The following
steps should be taken in the order presented until the problem is
resolved:

e Make sure that the TOPS InBox Init is in the System Folder.
e Use the Setup program to log in to your Mailbox.

e Use the Setup program and re-install InBox.

The message “Could not find Init” occurs.

If running under MultiFinder, the problem could be that the InBox
application is already open when running Setup. Try closing the
InBox application, and re-launching Setup. If not, then the Init may
not be in the same folder/volume as the Setup program. Copy the
InBox Init file into the InBox folder along with the InBox Setup file
and the other InBox files. Then launch the Setup program again to
perform the Install option.

The message “The InBox Init has not been run” appears.

Check that the InBox Init is in your System Folder. If other Inits are
loaded at boot time, try putting them in another folder and
restarting. If you can then run InBox successfully, then TOPS InBox
and another Init in your System Folder may be incompatible.

Also, Init “suppressors” like AASK, InitPicker, and Init may be
preventing InBox Init from running.

A Message Center isn’t visible to the InBox user program.
Normally, this is corrected by one of the following:

¢ Check with your InBox administrator to see that the Message
Center computer is turned on.

* If using AppleTalk, check to make sure that AppleTalk is
“active” on both the Message Center and your InBox software.
This is done by selecting the Chooser and selecting the
AppleTalk active button.

e If using Ethernet, make sure that EtherTalk is selected in the
Control Panel.

e If using a Macintosh Plus, check to make sure that the RAM—
based AppleTalk (Version 52 or later, which ships with InBox
3.0) is being used. This is done by selecting the AppleTalk file
in the System Folder and selecting Get Info from the File menu.

81




82

* [If using a file-server Message Center, check to make sure that
the appropriate volume is “mounted”.

* If using a mail-server Message Center, ask the administrator to
check if the Message Center is currently “Open”.

° If using a mail-server Message Center, ask your InBox
administrator to check the number of active connections on the
InBox Message Center via the Control Panel. This number
should be equal to or higher than the number of users that are
concurrently accessing the Message Center.

* Use whatever other network software is available on your
machine to access printers or network servers. If this software
is not functional, check cabling and connectors.

* If the Message Center is on another LocalTalk zone or Ethernet
cable segment, ask your InBox administrator to use the InBox
Administrator program or other network software to sce if
access can be obtained to any devices on the other zone. If not,
ask the network administrator to check the bridge between the
zones or cables,

* [If the Message Center has recently been moved, each user
needs to use Setup to repeat the log—in process.

The message “Corrupt Index File” occurs when starting
InBox.

Your Mailbox has been corrupted. This is unusual, but can occur.
Ask your InBox administrator to run the Recovery Utility which
comes with the InBox Macintosh Administrator. This program is
called RepairMC when using the DOS Administrator.

Remote users cannot find the Message Center when using
dial-in products (e.g. Shiva, Solana, Liaison, etc.).

The InBox Init attempts to find the Message Center when the
Macintosh is booted. If communication is not available at that time,

restarting the Macintosh after communication is established will
solve the problem.

The message “Not enough memory” occurs when attempting
to start the InBox Desk Accessory.

Memory is more limited for Desk Accessories than for applications.
If this occurs, you have the options of running InBox as an
application, not running other memory resident programs when
InBox is running, or adding memory to your Macintosh.

Appendix A. Troubleshooting
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Sending and Receiving Mail

A message arrives with an improbable time and date stamp.

Check the time and date of the computer from which the message
was sent, as well as the time zone that has been selected within the
InBox Setup application. InBox uses all of this information for
setting the date and time the message was sent.

A message appears with a question mark icon and torn off
memo icon, and the subject field "Incomplete Message."

The InBox software has discovered something about the message
that appears to be wrong. There is a great deal of checking done by
the software, and the problem could be of several types. The
message could have been incomplete when sent to your Mailbox,
or it could have been damaged during transmission. The following
steps are recommended:

1. Attempt to read the message. InBox attempts to retrieve the rest
of the message from the Message Center, if possible. If it is
readable, and you wish to save it, move it to a storage box.

2. If the message is not readable, quit InBox, restart InBox, and
try again.
3. If the message is still not readable, ask your administrator to

run the Recovery Utility on your Message Center or on the
Message Center from which the message came.

There is no alert when mail is received.
This could be caused by three things:

e You may have disabled alerts. Check in the “Customize” menu
for the current setting.

e You are running the InBox application when the mail is
received. Alerts only occur when the application is not running.

e The Init may not be running. Test this by attempting to start the
InBox client application.

Users receive several copies of the same message.

When using InBox Plus, this occurs when someone addresses a
message with a combination of individual addresses and
Distribution Lists, or nested Distribution Lists. Addressees will
receive the message once for each time selected. This can occur
when the sender uses the Select All button on a Message Center
that includes Distribution Lists. Make sure you de-select any
Mailbox names that are also included in Distribution Lists to prevent
sending multiple copies of messages.
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Messages appear in an unexpected order.

The default ordering of messages in the message list is first by
status or message type, and secondly by date and time within
message type. The message types, in order, are:

System messages

Urgent unread messages

1
2
3. Return receipt unread messages
4. Other unread messages

5

Read messages

The ordering can be changed by using Sort by... under the View
menu in the InBox application. The current sort order is indicated
in the InBox message list with an underline for the header of the
column you are sorting by, such as "Date." You can change this by
double—clicking on another header.

Enclosures are Missing.

A frequent problem is that the sender forgets to include the
enclosure before sending the message.

Enclosures are not saved to your File Copies (sent mail) or Drafts
Storage Boxes. InBox only saves the body of the message in these
Storage Boxes. Enclosures are not preserved in order to save disk
space and improve performance. To retain the enclosure you can
CC or BCC: yourself when you send the message.

Untranslatable or strange characters appear in a Received
Message

When receiving mail from machines using another character set
(e.g. between Macintosh and PC, or two PCs with different
character sets), certain characters have no equivalent. If the PC
detects this situation it warns the user that some characters could
not be displayed; the Macintosh displays a e in place of the
character.

Text imported into a message using the “Import Text”
function contains non-meaningful characters.

The “Import Text” function does not filter for standard ASCII
characters. Non-standard or hidden characters in the file inserted by
the word processor will be imported also. The user should create a
‘pure” text file using the appropriate word processor command
prior to importing into InBox. The file should be saved as “text—
only.”

Appendix A. Troubleshooting
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A long list of addressees is printed when printing a message.
The addressees are normally printed as part of the header of a
message when the message is printed. If a message is addressed to
many people, the addressee list could be quite long. If this is not
desired, use the Page Setup menu item and deselect the “Print
Header” box.

An “Invalid Message ID” error message occurs.

This message occurs when more than one user is accessing the
same Mailbox at the same time (using the “Use Mailbox”
command). The error can occur when one user deletes a message
and then the other user attempts to read the deleted message from
the same message list.

Mail is returned to the sender as "undeliverable".
This could be caused by several things:

e The destination Mailbox may have been deleted.

e The destination Message Center (containing the Mailbox you
sent to) is unavailable (that is, turned off, disconnected from
the net, etc).

¢ InBox Plus: The Router that connects your Message Center and
the one you are attempting to send to is down.

e There may be corruption in the Mailbox. This is unusual, but
can occur. The Recovery utility (called RepairMC on the PC)
may help; however, if the damage is severe, the Recovery
utility will completely remove (that is, delete) the Mailbox from
the Message Center. If possible, save all important memos and
enclosures to your local storage boxes before running the
Recovery program.

e There could be network cabling and configuration problems
that caused a connection to be broken while sending mail.

The messages “Connection Closing” or “Connection going
away” appear.

These messages occur when the communication portion of the
InBox software can no longer maintain a connection with the
Message Center. Causes of this could be:

¢ The InBox Message Center Server has been “Closed”.
e The Message Center computer has been powered off.

e A bridge between the user and Message Center is not working.

85



86

* For a File-Server InBox configuration, the network volume that
contains the Message Center has been unpublished.

* A problem with the network cabling has occurred.

InBox Plus: Mail is not delivered when is not being routed
between Message Centers.

There can be several causes:

¢ The Router is not running.
* Links are not set up between all Message Centers.

¢ The Router is having trouble connecting to a Message Center.
Check the Router log for errors.

InBox Plus: A Message Center that was removed from the
network can still be seen by all of the InBox clients.

To assure that a Message Center is not removed from the
addressing dialogues of other Message Centers simply because it is
powered off, the Router program waits 96 hours (a long weekend)
after a Message Center disappears from the net before it deletes the
information from other Message Centers.

InBox Plus: The message "Message not delivered to 'Red
Herring (file not found)" appears.

Red’s Mailbox has been removed, but your Message Center had not
been updated by the Router at the time that the message was sent.
Or, your Address Book was create prior to the deletion of his
Mailbox. You should try re-sending the message to the name as you
now see it in the Message Center.

Appendix A. Troubleshooting
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TOPS Technical Support

If you have persistent problems with InBox that the information in
this appendix did not resolve, contact your InBox and TOPS dealer
or international distributor. In the United States and Canada you can
also contact TOPS Technical Support. In either case, be sure to
have the following information about your system available:

Hardware Information

* Brand names, type or model of all computers involved:

® Brand names, type or model of all additional hardware in the
computers, such as accelerator boards:

* Make or model for all network interface cards:

* Type of connectors and cabling used by your network:

* Physical layout or arrangement of the stations on the network:

Software Information

¢ Version numbers for all InBox software:

Version numbers for all file serving software installed:

Version numbers for DOS or the Macintosh system and finder:
Version numbers for print spoolers or other system software:
Any relevant applications or system utilities and their version

numbers:
Problem Checklist

® Reproduce the sequence of events that lead to the problem.
* Write down any error messages that appear.
* Call from a location near your computer, with InBox loaded.

TOPS Contacts (United States & Canada) :

e TOPS Technical Support 415-769-8711
Call TOPS at the above number between the hours of 7:00 AM
and 5:00 PM Pacific Standard Time.

e TOPS Bulletin Board Service 415-769-8774

This bulletin board service is available 24 hours a day (1200 or
2400 baud/8 bits/1 stop bit/no parity).

e BIX Information Service
TOPS maintains a “conference” on BIX.. Enter: JOIN TOPS

¢ Compuserve

TOPS maintains a topic in the PC Vendors forum and in the
Apple Vendors forum.

— For PCs, enter: GO PCVEN
.— For Macintoshes, enter; GO APPVEN

¢« AppleLink
If you have access to AppleLink, you can send e—-mail to TOPS
Technical Support. Address it to D0098 .
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Glossary

Address list
A list of InBox users to whom you can address mail. It appears when you
click the Address button on a memo or phone memo.

Address book

A selective list of addressees drawn from the available address lists but
personalized for your use only. You can create personal Address books
which could contain entries organized, for example, by department,
project or individual choice.

AppleTalk

A set of network communication protocols developed by Apple. The
protocols route data packets between nodes and networks, assure reliable
end-to-end communication, and carry out other communication
management tasks. “AppleTalk networks” usually refer to networks which
use AppleTalk protocols on top of a LocalTalk physical networking
system.

ASCII

American Standard Code for Information Interchange. ASCII is a
standard way of representing alphanumeric English-language characters
and commonly used symbols and punctuation in microcomputer
operating systems.

Back up
To copy the contents of a disk, directory, or file to another hard or
floppy disk. (A backup file or disk is made in case the original becomes
damaged.)

Bridge

In general, a device that connects two distinct physical networking
systems, such as two different network cabling systems. AppleTalk
(EtherTalk) bridges, however, are routing devices that connect two
AppleTalk (EtherTalk) networks and control network traffic by passing
only communication packets going from one side of the bridge to the
other, that is between two different AppleTalk zones.
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Dialog box

A box that appears on the screen to prompt you for information during
a procedure. While a dialog box is open, you cannot perform any other
functions.

Disk
A device used to store information processed by your computer. Hard
disks and floppy diskettes are common storage devices.

Distribution List

A list of InBox addresses created by an InBox Plus administrator for use
network—wide. It appears as a single address on an InBox Plus Message
Center address list.

Ethernet

A physical nerworking system (communication chips, connectors and
cabling) used to link computers and peripheral devices together to
permit communication and data transmission. Cabling consists of
coaxial cable (“thick” or “thin” Ethernet), twisted pair and other types.
Ethernet transmits data at 10 megabits per second.

EtherTalk
Refers to networks that use AppleTalk protocols with Ethernet physical
networking systems.

File server
A station on a network that makes files available to other stations on the
network.

File—server Message Center
(See Message Center)

Finder

The application that maintains the Macintosh desktop. It keeps track of
documents and applications and transfers information to and from disks.
and enables applications to be launched.

Folder
Macintoshes store files in folders, which can be created within other
folders, forming a hierarchy of levels.

Gateway

A computer or, other device used to connect two usually dissimilar
networking systems, by providing a hardware connection and a software
interface between the two. :

e AppleShare Gateway

Usually refers to a device that links AppleTalk networks (sometimes
called a router).

Glossary
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* Mail Gateway
Usually refers to a device that links different mail systems. For
example, a gateway can provide an electronic mail interface beyond
the local InBox system to outside services such as AT&T Mail,
DASnet, Internet, etc.

Hierarchical file system (HFS)
A filing system used by the Macintosh operating system in which files are
organized according to a hierarchy of folders within folders.

Init
An “init” is a file stored in the Macintosh System Folder which is loaded
into memory each time the computer is started.

Local
Files, software or hardware stored in or connected to a computer.

Local Area Network (LAN)

A network localized in a single workplace or institution. Compared to a
wide area network, which spans long distances and usually links local area
networks.

LocalTalk

A physical networking system (communication chips, connectors and
cabling) developed by Apple and used to link computers and peripheral
devices together to permit communication and data transmission.
LocalTalk cabling also refers to any compatible cabling system, such as
TOPS Teleconnectors and PhoneNET connectors and twisted pair
cabling. LocalTalk transmits data at 230 kilobits per second.

Log in
The process of gaining access to a Mailbox or Message Center by
selecting a user name and typing in a password.

A group of messages collected by tan InBox Plus Message Center to be
delivered to another Message Center by an InBox Router at adminis-
trator—specified time intervals. Intervals are determined using the Router
software.

Mailbox

A group of files stored in the Message Center assigned to an InBox user.
This is where all messages for that user are delivered.

Mail-server Message Center
(See Message Center)
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Memory (Disk, RAM, ROM)
The data storage area of a computer system, usually composed of three
types.

¢ Disk memory is the main data storage area of a computer.

Application and data files are stored even with the computer turned
off.

¢ RAM (random access memory) is memory used to hold application
programs when they are being executed. Turning off the computer
clears the memory.

* ROM (read-only memory) is memory on which data is permanently
stored, or burned in. You cannot write to ROM.

Message Center

The central mail distribution center for an InBox system. Consists of a
collection of InBox Mailboxes and software for distributing incoming
messages. The workgroup InBox Administrator program creates Message
Centers that support 1 to 20 users. The InBox Plus Administrator
program creates Message Centers that support 1 to 100 users.

There are two Message Centers configurations mail-server and file—
server.

¢ Mail-server Message Center
A Message Center that can be used on an AppleTalk network. A mail—
server Message Center provides all the networking software required
to transport InBox messages over the network and does not require
file—sharing.

¢ File-server Message Center
A Message Center that uses the file-sharing capabilities of an existing
network to transport InBox messages.

Mount

To use your network software to connect to another computer and make a
directory or folder available to your own computer. You can read and
write to the directory or folder as if it were on your own computer.

MultiFinder
Macintosh system software which enables one application to process
information in the background while another application is running in
the foreground.

Multitasking

The ability to process information in the background while other
applications are running in the foreground.

Glossary
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Network

Computers, printers, and peripherals connected by a combination of
hardware and software to permit information exchange. The software
works according to communication rules, or protocols.

¢ AppleShare Network
Based on the AppleTalk communication protocols, a network that
provides file-sharing capability along with the basic AppleTalk
features.

e AppleTalk Network
A network that uses AppleTalk communication protocols and does
not support file sharing without additional software.

e Novell Network
A network that supports file sharing and connects networks using
varying types of communication protocols.

e File-Sharing Network
A network that lets you make files available to the network (publish
volumes) so that users on other machines can access the files (mount
volumes) as if they were on their own systems.

e TOPS Network
A network based on AppleTalk protocols that supports file sharing
and connects Macintosh, DOS, and Sun computers. It runs on either
LocalTalk or Ethernet cabling systems.

Notice to Users

A notice from the InBox system manager to all InBox users whose
computers are running and connected to the Message Center. The notice
appears temporarily in a dialog box displayed in the monitor
foreground on top of whatever program the user has running,

Password

A unique character string that the user must enter to access certain files,
folders, volumes, Mailboxes or Message Centers. Passwords provide
security for user materials stored in electronic form.

Path
The route through a hierarchical file system, from one directory down
through the hierarchy, to a file.

Protocols

A set of rules that govern the transmission of information across a
network. Many kinds of rules at different levels govern data
communication, just as in spoken communication.

Publish

To make a resource such as directory or folder available to other
computers on a network.
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Remote
Files, hardware or software stored in or directly connected to a station on
a network other than your own.

Root level

The top level of a hierarchical file system. On a Macintosh, if you open
your hard drive (double click on the hard disk icon in the Macintosh
Finder), the window that appears with the name of the hard drive visually
represents the “root” level in the file hierarchy. On a PC, the root level is
the topmost directory.

Router

A program that connects Message Centers so that InBox Plus software
can transfer mail between them. This feature is available only with InBox
Plus.

Server
A station that makes its resources, such as files, printers, and other
peripherals, available to other stations on a network.

Storage Box

A disk storage location where an InBox user can store messages he or she
has moved from his/her Message Center Mailbox. Usually on a local
hard drive.

Volume

A folder, directory, or subdirectory that has been published (made
available) to the network. (When a folder is published, all folders and
files in that folder are also published.)

Window

A work area within an application. When a window is active, you can
perform a particular set of tasks. A window is normally framed by a title
bar at the top containing a close box (to “close” the window) on the left
and a zoom box (to enlarge or shrink the window) on the right. If the
contents of the window are lengthy, a scroll bar on the right hand edge
may also be displayed. InBox contains message windows, message list
windows and help windows.

Zone

Large AppleTalk networks may consist of smaller networks that are
connected together. A zone is a logical grouping of connected AppleTalk
networks. Each network must be in a zone, and a zone can contain one or
more networks. Often each zone constitutes a single network.

Glossary
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A

Address Books

creating, 64-67

deleting, 67

editing, 67

InBox feature, 1

personal list, 38
addressing, messages, 38-44
address lists, Message Center, 38
Administrator diskette, for InBox DA file, 24
Alerts, changing, 76
applications, as enclosures, 36-38
ASCII files, importing, 35

B
bulletin board, (See Public Mailbox)

C

carbon copy memos, InBox feature, 1
changes, making, 76-77

choosing Fonts, 75

computer, system requirements, 10
Configuration, changing, 26

configuring InBox, 22-24

Control Pad buttons, selecting with, 28-29
controls, InBox, 28-30

Index

index

D

DA, (See Desk Accessory)
data files, as enclosures, 36-38
daylight savings time, 77
deleted messages, displaying, 59
deleting messages, 59
delivery time, 46
Desk Accessory

installing, 24-25

starting InBox, 27-28

using InBox, 11
discarding deleted messages, 60
disk storage, system requirements, 10
displaying deleted messages, 59
distribution lists, InBox Plus, 7-8, 42
documents, as enclosures, 36-38
draft message, saving, 47
Drafts Storage Boxes, storing messages, 57

E

editing text, 34

enclosures
attaching, 36-38
InBox feature, 1
paper clip symbol, 31
saving, 53-55
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File Copies
save option, 77
Storage Box, 32, 57
File menu, Quit option, 28
File Server access, worksheet information, 13
filtering messages, 62-63
Fonts, choosing, 75
footer information, entering, 34
forwarding messages, 53

G

Gateway Addresses
for Address Books, 66
selecting, 42
writing in, 43

Gateways, InBox Plus, 7-8

getting started, InBox basics, 27-30

H

hardware, system requirements, 10
header information, entering, 33
help, getting, 29-30

I

importing, ASCII files, 2, 35
InBox
basic components, 4
configuring, 22-24
controls, 28-30
getting started, 27-30
installing, 9-26, 14-15
overview, 1-8
quitting, 28
re-installing, 25-26
removing, 26
software, 3-4
special features, 71-78
system network platform, 5
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InBox (continued)
typical day example, 2-3
versions, 1
InBox administrator
Desk Accessory, 24
distribution lists, 42
gateway mail, 42
installation issues, 11
installing InBox, 9
Mailbox names list, 39
Public Mailbox, 72-73
InBox Plus
additional features, 7-8
communications, 5-6
Message Center capacity, 4
overview, 1
InBox Setup dialog box, selecting Config, 22
InBox User's Worksheet
information, 11-12
for installation, 13
installing InBox, 9
installation
InBox administrator issues, 11
preparing, 10-14
interoffice memos
InBox feature, 1
message form, 4, 31
opening, 51

K
keys, shortcut, 29

L
listing messages, 61-63
log in
changing, 26
Mailbox, 5
procedure for Mailbox, 15
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M
mail
managing, 61-70
receiving, 49-60
sending, 31-48
types, 4
Mailboxes
answering machine comparison, 5
at Message Center, 4
changing sort, 76
finding, 17-19
logging in procedure, 15
password, 20
using another, 71-73
making changes, 76-77
memory, system requirements, 10
memaos
opening form, 32-33
types, 31

* menus, selecting from, 29

Message Center
address lists, 38
InBox Plus capacity, 7-8
selecting, 16
for user Mailboxes, 4
zone location selection, 16
Message List
sorting, 50
messages
addressing, 38-44
creating, 34
deleting, 59
discarding deleted, 60
filtering, 62-63
forwarding, 53
inserting text file, 35-36
listing, 61-63
managing, 1
opening, 51
printing, 55-56
printing those sent, 77

Index

Messages (continued)
receiving, 49-50
replying to, 51-52
retrieving, 69
saving, 47
saving as text, 58
sending, 45
sending to yourself, 30
sorting, 5, 61-62
storing, 56-58
time and date, 23
undeleting, 60
undeliverable, 46

message window buttons, selecting with, 28

N

network, system requirements, 10

o

opening messages, 51
options, resetting, 76

P
page setup, setting options, 55
paper clip symbol, enclosure, 31, 53-55
password
bypass entering, 21
changing, 21, 76
forgetting, 21
Mailbox log in, 20
remembering, 77
phone memos
InBox feature, 1
message form, 4, 31
opening, 51
printing
messages, 55-56
sent messages, 77
private Mailbox, using, 72
public Mailbox, using, 72-73



Q

quitting
InBox, 28
Setup, 24
R

receiving messages, 49-50
replying to messages, 51-52
Return Receipt, opening, 51

S
saving
enclosures, 53-55
messages as text, 58
selecting
with buttons, 28-29
from menus, 29
sending, Mail, 31-48
Setup
quitting, 24
re-running, 26
running, 13-14
shortcut keys, using, 29

software, system requirements, 10

sorting messages, 61-62
Storage Boxes
creating, 69
deleting, 70
Drafts, 32 47, 57
File Copies, 32
renaming, 69
retrieving messages, 69
selecting folder, 22-23
storing messages, 5, 57
viewing, 68
working with, 67-70
System Folder

System Message, opening, 51
system requirements, hardware, 10

T

Times font, for printing, 35
time Zone, selecting, 23-24
TOPS InBox Help, getting help, 30

U

undeleting messages, 60
undeliverable messages, 46

A\

windows
keeping size and position, 74
keeping track, 73
message information, 74
working with, 73-74
workgroup InBox
communications, 5-6
Message Center capacity, 4
overview, 1

Z

zone location selection, Message Center, 16

for Desk Accessory, 11, 24
worksheet information, 13
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Here is your InBOX serial number:

133d

Affix this serial number sticker to your TOPS Registration
Card to insure proper registration of your InBox product.

800-4829-01

. TOPS Division, Sun Microsystems, inc.
SOFTWARE /HARDWARE LICENSE AND WARRANTY AGREEMENT

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING

THE SOFTWAR -
WARE. BY OPENING THIS PACKAGE YOU INDICATE YOUR COMPLETE AND UNCONDITIONAL ACCEEP('I?:N?:AERODF
THE TERMS AND CONDITIONS IN THIS DOCUMENT AND IN THE LICENSE ADDENDUM/PACKING LIST.

This document is a legal agreement between you, the end
user, and TOPS Divislon, Sun Microsystems, Inc.
{"TOPS"), concerning the use of the TOPS software and
hardware. THIS AGREEMENT CONSTITUTES THE COM-
PLETE AGREEMENT BETWEEN YOU AND TOPS.

AGREEMENT

1) LICENSE: For the purposes of this agreement "Software” shall mean
the software programs on the diskette. the software programs on any
hardware distributed by TOPS associated with the diskette and any
updates to such software programs distributed by TOPS. “Hardware®
shall mean hardware distributed by TOPS (including hardware distrib-
uted in association with software). You may make one copy of the
Software for back-up purposes. You may not electronically transfer the
Software from one computer to another over a network if in doing so. it
violates the terms of this Section 1 Except as provided herein. you may
not make or distribute copies of the Software or the operating manuais
associated with Software and associated Hardware ("Documentation”).
You may not modify. translate, adapt. reverse engineer. decompile.
disassemble, or create derivative works based on the Software nor may
you modify. copy translate, adapt or create derivative works based on the
Documentation without the prior written consent of TOPS. THE SOFT-
WARE AND THE MEDIA ON WHICH IT IS STORED REMAIN THE
PROPERTY OF TOPS.

se+p EASE REFERENCE THE LICENSE AGREEMENT ADDENDUM
TO DETERMINE WHICH OF FHE FOLLOWING IS APPLICABLE TO
YOUR REQUIREMENTS.***

SINGLE USER: You have the non-exclusive right to use and display the
enclosed Software programs on a single computer. You may physicaily
transter the Software from one computer owned or leased by you to
another provided that the Software is installed on only one computer at
atime. If you wish to use the Software on more than one computer. you
must license another copy of the Software for each computer.

: You have the non-exclusive right to use and display the
enclosed Software programs on a number of computers provided that the
number of installations does not exceed the limits as outlined in the
anclosed License Agreement You may phy Ily transfer
the Software from one computer owned or leased by you to another
provided that the number of installations does not exceed the limits as
outlined in the enclosed License Agreement Addendum. In the event
your requirements exceed the limits as outlined in the License Agreement
Addendum. you must purchase additional multi user licenses as appro-
priate to fulfill your requirements.

: You have the non-exclusive right to use and display the
enclosed Software programs on any number of computers provided thar
all such computers are owned or leased by a single company at a single
focation. You may electronically transfor the Software from one computer
owned or leased by you to another. at the same location. in accordance
with the license granted hersunder. In the event a company has more
than one location (defined as a separate street address). then a separate
site update license is required for each location.

2) LIMITED WARRANTY:
SOFTWARE: TOPS warrants to the original licensee only that the
Software shall operate substantially in accordance with the description
provided in the accompanying Documentation. Furthermore. TOPS
warrants that the media upon which the Software is stored is free from
defects of material or workmanship. The duration of these warranties. is
ninety (90) days from the date of original retail purchase. as evidenced by
a copy of the receipt. If the Software should fail to perform substantiatly
in accordance with the Documentation or you discover that the media is
defective at any time during this ninety (90) day warranty period. you must
promptly notify TOPS in writing and include a copy of your receipt with
such notice. Such notification must be received by TOPS within two
weeks of expiration date of the warranty period or it will be invalid.

HARDWARE: TOPS warrants to the original licensee only that the
Hardware shall operate substantially in accordance with the description
provi in the ing Documentation. Furthermore. TOPS
warrants this equipment against defects in materials and workmanship.
The duration of these warranties is one (1) year period. you must promptly
notity TOPS in writing and include a copy of your receipt with such notice.
Such notification must be received by TOPS within two weeks of explra-
tion date of the warranty period or it will be invalid.

After receipt of such notification. TOPS will use reasonable commercial
efforts to correct any such failure of the Hardware or Software. Such
repair, including both parts and labor. will be at TOPS' expense. Repair
parts and replacement Software or Hardware will be furnished on an
exchange basis and may be either reconditioned or new. If the media is
defective. TOPS shall replace the media within a reasonable period after
receipt of such notice. All replaced parts. Software and Hardware.
become the property of TOPS. All warranty service will be performed at
TOPS' designated facility and you will be responsible for the cost of
shipping the Hardware or Software to such location. You must also insure
the Software and Hardware during transportation or otherwise assume
the risk of loss during transit. if TOPS is unable to repair the Hardware
or Software after ar ble number of pts. TOPS. at its option,
will provide you with either a replacement or a full refund of the cost of the
Hardware and/or the license fee of the Software. TOPS will bear the cost
of shipping and risk of loss in sending such replacements to you.

This warranty gives you specific legal rights which may vary from state to
state. THESE REMEDIES ARE YOUR SOLE AND EXCLUSIVE REME-
DIES FOR ANY CLAIM RELATING TO THE PERFORMANCE OF THE
HARDWARE AND SOFTWARE.

3) LIMITATION OF WARRANTIES: The limited warranty does not apply
to: (a) any product, programs. components or parts not manufactured or
licensed by TOPS, (b) damage caused by disasters such as fire, flood.
wind or lightning. {c} d: caused by i attachments of

ificati (d) d: during ship or (@) any other abuse or

misuse.

4) DISCLAIMER OF WARRANTIES: THE WARRANTY SET FORTH
ABOVE IS IN LIEU OF ALL OTHER WARRANTIES AND REPRESENTA-
TIONS. EXPRESSED OR IMPLIED, INCLUDING THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
INFRINGEMENT OF THIRD PARTY RIGHTS. NO DEALER, AGENT OR
OTHER THIRD PARTY IS AUTHORIZED TO MAKE ANY MODIFICA-
TION. EXTENSION. OR ADDITION TO THE WARRANTIES IN THIS
AGREEMENT 400-1770-02




§) LIMITATION OF REMEDIES: IN NO EVENT SHALL
TOPS NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN
THE CREATION, PRODUCTION OR DELIVERY OF THE
SOFTWARE, HARDWARE OR DOCUMENTATION BE LI-
ABLE FORANY SPECIAL, INCIDENTAL, OR CONSEQUEN-
TIAL DAMAGES WHETHER BASED UPON BREACH OF
WARRANTY, BREACH OF CONTRACT, NEGLIGENCE,
STRICT LIABILITY IN TORT, OR ANY OTHER LEGAL
THEORY. Such damages include but are not limited to, loss
of profits, loss of savings or revenue, loss of use of the
Software or Hardware and any associated equipment or
software, cost of capital, cost of any substitute equipment,
facilities or services, downtime, the claims of third parties
including customers, and injury to property. Some states do
not allow the exclusion or limitation of incidental or conse-
quential damages so the above limitations or exclusions may
not apply to you.

Any claims against TOPS under this Agreement must be
brought within thirteen months after the date of the payment
of the license fee for the Software. In order to provide a forum
which is most experienced in dealing with these types of
Issues and the relevant statutes all claims arising under this
Agreement must be brought in the United States District
Court sitting in San Jose, California, and otherwise, in the
Superior Court of the State of California in Santa Clara
County.

6) INDEMNIFICATION FOR INFRINGEMENT:

(a) TOPS shall defend, at its own expense, any claim,
suit or proceeding brought against you Insofar as it is based
on a claim that the Software or Hardware constitutes an
infringement of a United States patent or a United States
copyright. To qualify for such defense and payment you
must: (1) give TOPS prompt written notice of any such claim;
and (2) allow TOPS to control and fully cooperate with TOPS
in the defense and all related settlement negotiations. TOPS
shall pay all damages, costs and expense finally awarded to
third parties against you but shall not be responsible for any
compromise made without its consent. TOPS shall have no
obligation to you for any claims made against you which arise
from use, sale, license or other disposition of the Software or
Hardware outside the geographic boundaries of the United
States.

(b) Once you notify TOPS of an alleged infringment or
it in TOPS' opinion such a claim is likely, TOPS shall have the
right, at its option, to obtain the right to continue the use of the
Software or Hardware, substitute other computer software or
computer hardware with similar operating capabilities, or
modify the Software or Hardware so that it is no longer
infringing. In the event that none of the above options are
available, your sole and exclusive remedy shall be to termi-
nate this Agreement, to cease using and return to TOPS all
copies of the Software or Hardware and to obtain from TOPS
a refund of the Hardware pursuant to this Agreement.

(c) TOPS shall have no liability for any claim of patent
or copyright infringement or other infringement of third party
proprietary rights resulting from: (i) your use of a combina-
tion of the Software with products or data not supplied by
TOPS; (i) any modification or attempt at modification of the
Software by you; or (iii) use of other than the latest release of
the Software received from TOPS, if such claim would have
been avoided by the use of such release.

7) LIMITATION ON LIABILITY: IN NO EVENT SHALL ANY
LIABILITY OF TOPS (WHETHER BASED ON AN ACTION
OR CLAIM IN CONTRACT, TORT, OR OTHERWISE) TO
YOU OR ANY OTHER PARTY EXCEED THE LICENSE FEE
OR PURCHASE PRICE CHARGED BY TOPS FOR THE
PRODUCT CAUSING THE INJURY ON WHICH SUCH
ACTION OR CLAIM IS BASED. THIS LIMITATION SHALL
NOT APPLY TO PERSONAL INJURY OR DEATH CAUSED
BY TOPS HARDWARE OR SOFTWARE.

8) TRANSFER: The Software is licensed solely to you, the
licensee. You may transfer this license to another party only

it the other party agrees to the terms and conditions of the
Agreement and completes and returns a Registration Card to
TOPS. IF YOU TRANSFER THE SOFTWARE, YOU GIVE
UP YOUR OWN RIGHT TO USE THE SOFTWARE. At the
time of transfer, you will inform TOPS in writing that a transfer
Is occurring. At the same time, you must transfer (i} the
Documentation, (i) all Hardware, if any, associated with
Sofiware, (iii) the Software and (iv) destroy ali other copies of
the Sof @ or D wtation.

9) LIMITATION ON FOREIGN TRANSFER: The Hardware
and the Software are subject to the limitation on transfer
Imposed by the Export Administration Act of 1979, as
amended by the Export Administration Acts of 1981 and
1985. You agree not to transfer the Hardware or Software
outside of the country in which you have received it unless
you have secured the appropriate permission from the United
States Department of Commerce. In particular you agree not
to, without prior authorization (if required) of the Office of
Export Licensing ("OEL"), U.S. Department of Commaerce,
14th and Constitution Ave., N.W., Washington, D.C. 20230,
axport, re-export, or otherwise disclose, diractly or indirectly:
(i) the Software; or
(ii) the immediate product (including processes and

services) produced directly by use of the Software to the
following countries, or residents or citizens of such countries:
Afghanistan, Albania, Bulgaria, Cambodia, Cuba, Czecho-
slovakia, Estonia, The German Democratic Republic, Hun-
gary, Laos, Latvia, Libya, Lithuania, the Mongolian People's
Republic, Nicaragua, North Korea, the People's Republic of
China, Poland, Romania, the U.S.S.R. and Vietnam.

10) COPYRIGHTS AND TRADE SECRETS: This Software
Is protected under the copyright law of the United States and
other countries. TOPS owns all rights regarding the Soft-
ware. This Agreement does not convey ownership of the
Software to you, but only the right to use a copy of the
Software strictly in accordance with this Agreement. The
unauthorized reproduction or distribution of the Software or
the Documentation is an infringement of TOPS' copyright and
may subject the violator to criminal as well as civil penalties

11) TERM: THIS LICENSE AGREEMENT IS EFFECTIVE
FROM THE DATE OF ORIGINAL RETAIL PURCHASE OF
THE SOFTWARE OR HARDWARE and continues until it
terminates as provided below or you transfer it to another
party pursuant to Section 8. This license will also terminate
immediately, without notice from TOPS if you fail to comply
with any term or condition of this Agreement. You agree upon
termination of this Agreement to immediately cease use of
the Software and, except in the case of a transfer pursuant to
Section 8, to immediately destroy or return to TOPS the
Software, the Hardware and the Documentation.

12) UPDATE POLICY: In order to be eligible to obtain
updates of the Software, you or the person to whom the
program is transferred in accordance with Section 8, must
complete and return the Registration Card to TOPS. If this
Registration Card has not been received by TOPS, TOPS is
under no obligation to make available to you any updates. All
updates provided to you shail become part of the Software
governed by the terms of this Agreement. TOPS reserves the
right, at its sole discretion, to pravide updates on a site basis
or an individual node basis. (Please reference Section 1 and
License Agreement Addendum for applicable option.) TOPS
agrees {o offer you updates in accordance with its current
update policy but reserves the right to provide no updates, to
charge a fee for updates or to otherwise modify its update
policy without notice.

13) MISCELLANEOUS: This Agreement and associated
License Agreement Addendum supersedes and replaces any
and all oral or written agreements with respect to the Soft-
ware and Hardware. This Agreement shall be governed by
the laws of the State of California, without regard to the
contlict of law provisions thereof, as if it was performed
wholly within the state.




Before you read the documentation...

inBox 3.0.E for Macintosh
User's Release Notes

These Release Notes supplement information in the User's Guide
to InBox for Macintosh. For information regarding other InBox
products, please see the Release Notes for those products.

If you are installing InBox on a floppy disk Macintosh (no hard
disk), first read the Floppy Disk Installation instructions (page 12)
in this note. Read the rest of this note after you read the manual.
If you are installing on a hard disk, read these notes after you read
the User’s Guide. These notes are organized as outlined below.

New Features page 2
The new features in this release allow you to:

e Search for addresses page 2
(Mailboxes or Distribution Lists)

e Set how often you are notified page 9
of the arrival of new mail

e Access your mail easily from page 10
another Macintosh (public access)

Supplemental Information page 12
Additional information not included in the
User’s Guide to mBox for Macintosh.

Applications Compatibility page 16
A list of the applications that have been

tested by TOPS and found to be partially

compatible or incompatible with InBox 3.0.E

user's software for Macintosh,

Known Limitations of InBox 3.0.E page 18

A list of known limitations of InBox 3.0.E
user's software for Macintosh.

ImBox 3.0.E for Macintosh: User's Release Notes ' 1



New
Features

InBox Search

This section describes features that are new to this version of
InBox and explains how to use them. They provide you additional
flexibility and more power as an InBox user.

The Search feature lets you find an InBox address (Mailbox or
Distribution List) when you are unsure of the exact name or
location of the address. For example, you might want to send mail
to a particular person but you don’t know her last name or which
Message Center (if you have more than one) contains her
Mailbox.

You can use Search when you are:

e Sending 2 message and need to find an address.
e Creating or editing an Address Book and need to find an
address to add.

The Search feature is available from both the Address dialog box
(for addressing messages), and the Address Book dialog box (for
creating Address Books).

The following pages describe how to use Search in these two
situations.

Searching for an address (Mailbox or
Distribution List) when sending a message

The steps below explain how to search for an address (Mailbox or
Distribution List) that you need to send a message. This
procedure assumes that you have read “Addressing a Message” in
Chapter 4 of your User’s Guide.

To find an address:

1. Open or create a message you wish to send.

2. Click Address... on the open message window.
You see the Address dialog box.

mBox 3.0.E for Macintosh: User's Release Notes



New Features

3. Select Search... from the pop-up menu “A”,

Send: @To QCC QBCC

L Message center: || Engineering

Administrator

((setectnn ) [ clear )

Place the mouse pointer on “A” and press the mouse button,
You see the pop-up menu below. Pull down to Search... and
release the mouse button.

Send: @To QcCC QBCC

Message center:
Address book:

Search... CJ
......... -:_ |

........................................... : Sond o




4.

5. Type the characters for which you want to search.

Keep in mind that these searches are character specific, but
not case sensitive. You can search for “Rob” or “rob” and
you'll find all the Mailboxes titled Rob, Robb, Robert or
Roberta. However, if you’re looking for Robert and type

After you select Search..., the Search dialog box is

displayed.

Search for addresses that

@ begin with Qcontain O end with
the following characters:

[Rob —|

) ("cancer ) {Thiusers )

If you know what characters the name:

e begins with, click the begin with radio button.
e contains, click the contaln button.

e ends with, click the end with button.

“rbrt”, it won't be found.

You can also use Search to list all the Mailbox names and
Distribution Lists in your InBox system. Click once on the “All
users” button. “All users” ignores any search criteria. It lists

all InBox Mailbox names and Distribution Lists.

Click Find to start the search.-
A progress box is displayed.

Seorching for "Rob"

(Type Command-Period (X-.) to halt)
Message Centers remaining: 12 Rddresses found:

2

The first time InBox searches across multiple Message
Centers, it may take some time. Subsequent searches in the

same session are much faster.

ImBox 3.0.E for Macintosh: User's Release Notes




When the search is complete, the set of characters for which
you searched appears in “A” (shown below), and all found
addresses are displayed in the address list below it

Send: @To QOCC QOBCC

E .‘::lbllﬂ.fll eering {}l 0K '

(setect ani ) [ clear )

You can select from among these addresses, found through
search, as you would any other address list.

Note: If you want to cancel the search, press Command-Period
(38-.). This stops the search and displays the results found
until the search was stopped. The word “Partial” is displayed
in box “A”, shown in the graphic below.

If your search address list has too many addresses to be
useful, you can search this list again to further limit it
Suppose, for example, there were 100 “rob” addresses. You
can select Search... again from the pop-up menu and type
“robert.”

After performing a search, you can select addresses from
other sources (Message Centers or Address Books). You can
also return to the list of addresses you have found in your
previous search by selecting the name (shown below the
Search... option) of your previous search.

: BCC
Message center:
Address book: doc Group |
Search...

.......... P "

New Features 5



Searching for an address (Mailbox or
Distribution List) for an Address Book

The steps below explain how to search for an address (Mailbox or
Distribution List) that you need to create or edit an Address Book.
This procedure assumes that you have read “Creating an Address
Book” in Chapter 6 of your User’s Guide.

To find an address for an Address Book:

1. Select Address Book from the Customize menu.
2. Click on New, or Edit, in the Address Book’s dialog box.
3. Select Search... from the pull-down box “A”,

_‘LL Message center: | [ Engineering ]

A
ohn Comnon [ 2oc roue
ey Jack Ch:otnglnesri ko

ng

::2:: :‘..':,::, N |Maria Sanchez@Engineer Remoue
Philip Chin 8 |LisaChin@®Engineering __
Jack Chel Seth Cohenn@Engineerin
Jane Williams ([ |Nadia Krasne @Engineeri Gateway
Rlex Rose 37 Addresses
Chariis Waiiace [pua..)(£awt...)

Place the mouse pointer on box “A”, press the mouse button,
pull-down to Search... and release the button. You see the
pop-up menu below.

Message center:
Rddress book:
Current memo

Engineering

Doc Group:

Jack Choi ®Engineering
Previaus seardh Maria Sancheze£ngineer
Maria Sanchez Lisa Chin®Engineering
John Cannon seth Cohenn@Engineerin
Philip Cohen Nadia Krasne @Engineeri
MBI"! Stevens
Philip Chin

Jack Chol

mBox 3.0.E for Macintosh: User's Release Notes



New Features

After you select Search..., the Search dialog box is
displayed.

Search for addresses that

@ begin with QO contain O end with
the foliowing characters:

[Rob ]

~ ) (cancel ) ((Aiusers )

If you know what characters the name:

e begins with, click the begin with radio button.
e contains, click the contain button.

e ends with, click the end with button.

Type the characters for which you want to search.

Keep in mind that these searches are character specific, but
not case sensitive. You can search for “Rob” or “rob” and
you'll find all the Mailboxes titled Rob, Robb, Robert or
Roberta. However, if you're looking for Robert and type
“tbrt”, it won't be found.

You can also use Search to list all the Mailbox names and
Distribution Lists in your InBox system. Click once on the “All
users” button. “All users” ignores any search criteria. It simply
searches for all InBox Mailbox names and Distribution Lists.

Click Find to start the search.
A progress box is displayed.

Searching for "Rob”

(Type Command-Period (%-,) to halt)
Message Centers remaining: 12 Rddresses found: 2

The first time InBox searches across multiple Message
Centers, it may take some time. Subsequent searches in the
same session are much faster.




Note:

When the search is complete, the set of characters for which
you searched appears in “A” (shown below) and all found
addresses are displayed in the address list below it

Il
A

Rob Das@Enginee

Doc Group: (—
Robb Foster®Eng L Show ns I

Jack Chol ®Engineering

Marla Sancheze@Engineer LE
Lisa Chin®@Engineering

Sath Cohenn®Engineerin

Nadia Krasne @Engineerl Geileway
Addrasses

Add

You can add to your Address Book from these addresses, as
you would any other address list.

If you want to cancel the search, press Command-Period
(%8-2). This stops the search and displays the results found
until the search was stopped. The word “Partial” is displayed
in “A”, shown in the graphic above.

If your search address list has too many addresses to be
useful, you can search this list again to further limit it
Suppose, for example, there were 100 “rob” addresses. You
can select Search... again from the pop-up menu and type
“robert.”

After performing a search, you can select addresses from
other sources (Message Centers or Address Books). You can
also return to the list of addresses you have found in your
previous search by selecting the name (shown below the
Search... option) of your previous search.

Message center:
Address book:
Current memo
Search...

Maria Sanchez
John Cannon

Philip Cohen

Doc Group:
Jack Chol

mmBox 3.0.E for Macintosh: User's Release Notes



New Mail
Notification
Frequency

New Features

InBox now lets you set how often InBox will notify you of the
arrival of new mail. By default, InBox notifies you once a minute.
You can set this notification interval to be anything from 0 to 60
minutes. You can also turn the notification off when you don't
expect to receive mail. For example, if you take your Macintosh
home, or away from the network, you can turn the notification
feature off to avoid delays as InBox checks for new mail.

To set the Notification Interval:

1. Select Control Panel from the #§ menu,

2. Click on the TOPS InBox Init.
You see the InBox Notification settings.

Control Panel 0|

_ ”| TOPS InBox Notify when new mail
&) Notification arrives

Set Notification Interval
(in minutes)

Startup Device

€

TOFE nEss

TOPS InBox ...

B33

3. Set the Notification Interval by clicking on the up or

down arrows.

The shorter the interval, the more often you are notified of
new mail. However, the more you are notified the more traffic
you put on your network. If, when using InBox or when
working in another application, you notice delays or a
slowdown in response lime, try increasing the Notification
Interval.

To turn notification off entirely, uncheck the checkbox that is
titled “Notify when new mail arrives.”



Public Access

10

Remember: If you take your Macintosh off the network (such
as taking it home) and you notice your machine pausing for a
few seconds periodically, turn off the notification until you
reconnect to the network.

4. Close the Control Panel by clicking on the close box.
The new Notification Interval takes effect immediately. You
don't need to reset your Macintosh.

With the public access feature you don't need your own
Macintosh to use InBox. You can use any InBox user’s Macintosh
that is connected to your Message Center to send or read your
mail. You don't have to know the other InBox user’s password,
and you can read or send mail without violating that user’s
password security.

With this feature, many users can share one Macintosh in a public
area. This is especially useful if people work away from their desks
but want to continue to read and send mail. For instance, your
InBox administrator can set up a Macintosh for this purpose in a
meeting room, lunch room, laboratory, or library.

To use this feature, the InBox user software installed on the
Macintosh must require a password to access mail. See “Log in
with Your Password”, Chapter 2 in the User’s Guide. If the
Remember Password option is checked, you will not see the
Password dialog box.

1. Double<click on the TOPS InBox application.
You see the Password dialog box shown below.

Password for Mailbox Tamara Nicoloff

| |
[Concel] [ Switch Mailbox ]
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2. Click on Switch Mailbox.
You see a list of all the Mailboxes on the Message Center 1o
which the Macintosh is currently connected.

Change Mallbox te:

Rdministrator
Maria Sanchez
John Cannon
Philip Cohen

Janet Ultallace
Philip Chin
Jack Choi

Rysia Lasman
Nadia Krasne

3. Click on your Mailbox name and click OK,
4. Enter your password.

Password for Mallbox Janet Wallace

I |
5. Click on OK.
You see the messages in your Mailbox. You are now logged
in to your Mailbox. Although you can read and send mail,

you cannot use Storage Boxes or your personal Address
Books.

6. When you finish your work, quit InBox.
When you quit InBox, the next user can repeat the process
above. He or she will not see your mail.

New Features 11
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Note

This section contains information that supplements or makes
corrections to the User’s Guide to InBox for Macintosh. It
includes information on Floppy Disk Installation, User Interface,
Sending Mail, Storage Boxes and Troubleshooting:

Below are the instructions for how to create InBox disks for
floppy drive Macintoshes. There are three ways: Installing from a
Hard Drive to a Floppy Start-Up Disk; Installing on a Dual Floppy
drive Macintosh; Installing from a Network File Server.

You will be unable to install the InBox Desk Accessory on an
InBox floppy start—up disk. There is not enough room on a single
disk for the System files and the InBox Desk Accessory.

Installing from a Hard Drive to a Floppy Start-
Up Disk
1. Create a start—up disk with a System and Finder on it.

2. On a Macintosh with a hard drive, copy all of the files
from the InBox User's disk onto the hard drive.

3. Eject the InBox User's disk and insert the start-up disk
that you have created.

4. From the hard drive, launch TOPS InBox Setup.
Click on the Drive button to change drives to the floppy
start-up disk.

5. Click on the Install button.
TOPS InBox Setup will install the TOPS InBox Init into the
System Folder on the floppy start—up disk.

6. Select a location for the rest of the InBox files to
reside by using the Drive button.

7. Continue as documented in the User's Guide.

Installing on a Dual Floppy Drive Macintosh

1. Insert your start—up disk in drive A and turn on the
Macintosh. -

2. Insert the TOPS InBox User's Disk in drive B.
From drive B, launch TOPS InBox Setup.

InBox 3.0.E for Macintosh: User's Release Notes
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4.

6.

7.

Click on the Install button.
TOPS InBox Setup will install the TOPS InBox Init into the
System Folder on the floppy start-up disk.

Select a location for the rest of the InBox files by
ejecting the start-up disk, and inserting another disk.
If the InBox User's Disk is locked, a message will appear
saying "Disk is Locked." Click OK when you see this message.
Setup will now allow you to insert a new disk in drive A.

After several disk swaps, select your Storage Boxes
location.

Eject the start—up disk from Drive A, and insert the InBox disk
you created in Step 5.

Continue as documented in the User's Guide.

Installing from a network File Server

On a single floppy computer, with a file server access (such as
TOPS or AppleShare), follow these steps.

1.

woR N

a

9.

Insert the start-up disk in the drive and turn on your
Macintosh.

Mount your network volume(s).
Eject the start-up disk.
Insert the InBox User's Disk.

Copy TOPS InBox Setup, TOPS InBox, TOPS InBox Init
and TOPS InBox Help from the InBox User's disk to a
folder on the mounted network volume.

Eject the InBox User's disk.
Insert the start-up disk.

Copy the TOPS InBox Init from the network volume
into the System Folder of the start—up disk.

Launch TOPS InBox Setup on the file server volume.

10. Click on Log In and Config.

Refer to the User's Guide for more information about these
steps.

11. Click on Quit.
12. Restart your Macintosh

13
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Importing Graphics

You can only import text into InBox messages, you cannot
import graphics files.

Enclosures with Forwarded Messages

Enclosures associated with a forwarded message are
forwarded. However, you cannot add additional enclosures to
this message.

Enclosures when you Reply

Enclosures associated with a message are not returned to the
original sender when you reply to a message. You can,
however, attach your own enclosures to this message.

Sorting of Address Books

Regardless of the sort order that you have established for
viewing Message Center mailbox names, names in Address
Books are always sorted alphabetically by first name.

Erasing Storage Boxes

When erasing a Storage Box, you must first delete all
messages that are in it, and discard deletions. If you do not,
you will get the message “Only empty Storage Boxes can be
deleted.” There are two ways to discard your deletions. One
way is to close the Storage Box. The other way is to select
Discard Deletions from the Edit menu.

Locating Storage Boxes

If you change the name of the hard drive on your Macintosh,
InBox will be unable to locate your Storage Boxes. The next
time you log in, InBox will ask you if you want to reselect your
Storage Boxes folder.

Moving and Copying Messages to Storage Boxes

There is a feature not documented in the User's Guide which
allows you to drag selected messages into open Storage
Boxes. To move a message to a Storage Box, select the
message, hold down the mouse button until the mouse
pointer turns into a memo icon, and then drag the message
to the open Storage Box. To copy a message to a Storage Box,
hold down the Optlon key, select the message, hold down the
mouse button until the mouse pointer turns into a memo
icon, and then drag the message to the open Storage Box.

Moving Storage Boxes from One Computer to Another
To move a Storage Box to another computer, follow these
steps, while InBox is not currently active.

1. Copy the source Storage Box onto a floppy disk, or
use a network file server.
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2. Copy the source Storage Box file from the floppy
onto the target computer's Storage Boxes Folder,

3. Start InBox. You will now see the newly created
Storage Box.

Changing Time Zones
When you change time zones using TOPS InBox Setup, you

must restart your Macintosh for the change to take effect.

Using Arrow Keys

There is a feature not documented in the User's Guide which
allows you to the arrow keys to move through the message list.
You can also use the return key to open a highlighted

message.

You are Unable to See the Message Center

If you are unable to see a Mail-Server Message Center, and
have previously been able to access the Message Center, or if
you are only able to access the Message Center when a few
people are using it, ask the InBox administrator to increase
the number of active and simultaneous users set in the TOPS
InBox Server Init on the Message Center Macintosh.

You are Unable to See the Message Center

The RAM-based AppleTalk file (Version 52) is included on
the Administrator disk for use by Message Centers that are
Macintosh Pluses. Without this file 2 Macintosh Plus running
the InBox Administrator or User software will be unable to
see the Message Center when the Message Center is local.

Additionally, if a Mac Plus InBox user on the network has
difficulty finding the Message Center the RAM based
AppleTalk file may help.

“Not Enough CCBs” Error Message

If you receive this message, ask the InBox Administrator
increase the number of simultaneous and active users set in
the TOPS InBox Server Init on the Message Center Macintosh.

“The Contents Field will be Truncated” Error Message
You may receive this message while opening several
messages. This message indicates that you are running low on
memory, and may not be able to see the all of the contents of
one or more messages.

This Message Inexplicably Missing. Sorry.

This message may occur when your Macintosh is running low
on memory. To alleviate the problem, try closing some of
your open messages, use the InBox application instead of the
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Desk Accessory, unload other inits, or if using MultiFinder,
quit other open applications.

Using the LaserWriter 6.0 Drivers

If you are using the LaserWriter 6.0 Drivers, and messages are
not printing or are taking a long time to print, select black
and white printing, instead of the default for color printing.

“MCP Not Connected” Error Message

If the Message Center disconnects from the network abruptly
you may see the message “MCP not connected.” This means
that you are no longer connected to the Message Center, and
should unmount the Message Center volume.

Disconnecting from the Message Center

If your Message Center disconnects, or if you disconnect your
Macintosh from the network, you may notice that activity such
as word processing, may slow periodically. If you are going to
be disconnected from a Message Center for long periods of
time, it is best to not load the TOPS InBox Init by holding
down the Shift key when your Macintosh starts up, since InBox
continues to poll the network, trying to reconnect to the
Message Center.

A number of applications have been tested by TOPS and a few
have been found to be incompatible or partially incompatible
with InBox 3.0.E. The following notes describe some methods to
work around these incompatibilities.

FileMaker II Release 1 by Claris

FileMaker II at run time allocates all available memory minus
approximately 80K. For this reason, FileMaker II and the
InBox Desk Accessory are incompatible. The work—around is
to use MultiFinder and the InBox application instead of the
Desk Accessory.

When using FileMaker in Network mode, if you experience
screen refresh problems when you receive visual alerts, turn
off video alerts within InBox.

Network Helix Version 3.0r1 by Odesta

When using Double Helix in Network mode, if you experience
screen refresh problems when you receive visual alerts, turn
off video alerts within InBox.

Shiva Dial-In

If you are using Shiva Dial-In software on a Macintosh to
connect to a remote InBox Message Center via Shiva
NetModem or NetSerial, after you switch to a dial-in con-
nection in the Control Panel, and dial in to the remote net-
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work, you will have a short delay before InBox notes the
change in the network connection and adjusts for it.

Solana Dial-In

In configuring the Solana Dial-In software you can place the
following three characters into the password prompt <#>,
Your will then receive a message stating that the remote
network will be dialed upon your next restart. At this point,
restart you Macintosh and the Solana dial-in software will
connect to the remote network. You will be able to see zones
in the Chooser and log in to the Message Center.

LAN Ranger by Kinetics

If you run LAN Ranger, you must restart the Macintosh before
using InBox User's software. If you don't restart, your
computer may be unable to communicate with the Message
Center, may hang, or a System Bomb may occur.

Front Desk by Layered
Running the InBox Desk Accessory while in Front Desk can
cause Front Desk to crash.

Full Write 1.0 by Ashton Tate

Full Write 1.0 at run time allocates almost all available
memory. For this reason, Full Write 1.0 and the InBox Desk
Accessory are incompatible. The work-around is to use
MultiFinder and the InBox application instead of the Desk
Accessory. InBox is fully compatible with Full Write 1.1.

AppleShare by Apple

If you have TOPS, AppleShare client software, and InBox
installed when you start your Macintosh, you will receive the
message “Too many open files” when connecting to a File-
Server Message Center. InBox will continue to work in this
configuration, but yeu may see this message frequently. To
avoid this problem, do not load AppleShare or TOPS with
InBox when you start your Macintosh.

Pyro! 3.3 by Fifth Generation

If you use Pyro! 3.3, the InBox flashing memo icon that
indicates that new mail has arrived can still be seen, even
when the screen saver is active,

Microphone II by Software Ventures
InBox is incompatible with Microphone when Microphone is
used as a start-up application. The work-around is to launch
Microphone manually when using InBox.
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The following list itemizes functionality and features that have not
yet been fully implemented in the version of InBox 3.0.E. The
following notes describe some methods to work around these
limitations.

Copying Messages to Another Storage Box

If you select all of the messages in a Storage Box and copy
them to another Storage Box, the order in which the mes-
sages are displayed is reversed, even when using the same sort
order.

InBox on a Single-Floppy

Due to the need to do many disk swaps, it is not recom-
mended to run InBox user software on a single-floppy
Macintosh with no hard drive, second floppy, or mounted
network volume. Refer to the first section of these Release
Notes for information on floppy disk installations.

InBox Preferences

If you must re-install InBox for any reason, your settings (e.g.
login name and password) will be saved in the TOPS InBox
Preferences file in your System Folder. Settings that aren't
saved are Save File Coples and Sort Mailboxes by...
which can be re-selected in the Customize menu, under Set
Options.

Saving as Text to the Storage Boxes Folder

Do not put anything into your Storage Boxes Folder. If you
save message as text, for example, in the Storage Boxes folder,
and later create a Storage Box with the same file name, InBox
will overwrite the file and replace it with a Storage Box file.
You will not receive a message when this happens.
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